Poglavije 2

Izrada radnog lista od samog
pocetka

U ovom poglaviju
Otvaranje nove radne sveske
Upisivanje tri razliCite vrste podataka u radni list
Svojerucna izrada jednostavnih formula
Ispravljanje sitnih greSaka prilikom upisivanja podataka
Upotreba opcije AutoCorrect
Glasovno uno$enje podataka u radni list i zadavanje naredaba
Svojerucno upisivanje podataka u radni list
Upotreba opcije AutoFill za kompletiranje niza upisa
UnoSenje i uredivanje formula koje sadrze ugradene funkcije
Sabiranje brojeva po redovima i kolonama dugmetom AutoSum

Kako da saCuvate svoje dragocene rukotvorine i vratite radne sveske
posle pada sistema

Sad kad znate kako da pokrenete Excel 2003, vreme je da otkrijete na
koje se sve nacine zapada u teSkoce njegovim koris¢enjem! U ovom
poglavlju naucicete kako se unose sve moguce vrste informacija u prazne
Celije po radnim listovima koje smo opisali u poglavlju 1. Upoznacete se
sa Excelovim opcijama AutoCorrect i AutoComplete i njihovom prime-
nom za smanjenje broja greSaka i ubrzanje rada. Dobicete i osnovna
uputstva o nacinima za izbegavanje monotonije pri unoSenju podataka,
na primer, prilikom unosa nizova podataka pomocu opcije AutoFill

i upisivanja jednog istog podatka u grupu celija u jednom koraku.

Kada otkrijete kako se radni list popunjava podacima, saznacete i ono
najvaznije: kako se informacije Cuvaju snimanjem na disk, tako da ih viSe
nikada ne morate ponovo unositi!
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54 Deo I: Ulazak na esnovni nivo

Dakle, sta da upisete u svoju novu
radnu svesku?

Kada Excel pokrenete a da prethodno niste definisali i dokument koji
treba otvoriti u isto vreme, na primer, kada pokrenete program iz menija
Start Windowsa XP (pogledajte poglavlje 1), dobicete praznu radnu
svesku u novom prozoru. Ova radna sveska privremeno nosi naziv Book1
i sadrZi tri prazna radna lista (engl. worksheef) (€iji su nazivi Sheet1,
Sheet2 i Sheet3). Rad na novoj proracunskoj tabeli po¢nite unosenjem
podataka u prvi list radne sveske Bookl u prozoru radne sveske.

Detalji unosenja podataka

Sledi nekoliko osnovnih uputstava (neka vrsta pravila lepog ponasanja
prilikom unoSenja podataka, ako se tako moZze reci) kojih se treba
pridrzavati tokom izrade radnih listova i radnih svezaka:

v Trudite se da informacije organizujete u tabele podataka smestenih
u susednim redovima i kolonama. Tabele poc¢nite da pravite tako
§to Cete, kad god je moguce, ic¢i od gornjeg levog ugla radnog lista
naniZe, radije nego udesno. Kada je pogodno, razdvajajte tabele
samo sa po jednim redom ili jednom kolonom.

v Kada zavrsite sa formiranjem tabela, nemojte ostavljati prazne
redove ili kolone izmedu njih, samo zato da biste ,nekako razdvo-
jili“ informacije. U poglavlju 3 videcete kako se po Zelji podeSava
prazan prostor izmedu susednih tabela prosirivanjem kolona
i redova, i podeSavanjem poravnanja.

v Ostavite jednu praznu kolonu s leve strane tabele za zaglavlja
redova.

v Ostavite jedan prazan red iznad tabele za zaglavlja kolona.

v Ako je tabeli potreban naslov, postavite ga u red koji se nalazi iznad
reda sa zaglavljima kolona. U slu¢aju da tabela ima zaglavlja redova,
naslov postavite u istu kolonu u kojoj se nalaze ta zaglavlja. U
poglavlju 3 naucicete kako se naslov centrira preko svih kolona
tabele.

MoZda se pitate zaSto vas, posle tolike price o veliCini radnih listova

u poglavlju 1, upozoravam da ne iskoristite sav taj prostor i da ne raz-
bacujete podatke po radnom listu gde god vam se prohte. Na kraju kra-
jeva, sa svim tim prostranstvom na samo jednom Excelovom radnom
listu, uSteda prostora je poslednja stvar o kojoj bi trebalo brinuti.

[ tu biste bili sasvim u pravu... da ne previdate jednu malecku, sicusnu
Cinjenicu: uSteda prostora na radnom listu jednaka je ustedi memorije.
Kako tabela sa podacima raste i Siri se po kolonama i redovima u nove
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Poglavlje 2: Izrada radnog lista od samog pocetka

prostore radnog lista, Excel odlucuje da rezerviSe izvesnu koli¢inu memo-
rije i Cuva je otvorenom za slucaj da iznenada pomahnitate i popunite
podacima sve Celije koje ste na poCetku ostavili praznim. To znaci da ako
bez stvarne potrebe ostavljate prazne redove i kolone (samo zato da biste
»lepo sredili“ podatke), nepotrebno cete angazZovati memoriju racunara
koja se inaCe moZe iskoristiti za smeStanje novih podataka na radni list.

Ovo ne smete zaboraviti...

Sad vam je jasno: krajnja veli¢ina radnog lista odredena je koli¢inom
memorije u racunaru, a ne ukupnim brojem ¢elija po radnim listovima
radne sveske. Kada utroSite svu memoriju, ostali ste u stvari bez slobod-
nog prostora — bez obzira na to koliko je kolona i redova ostalo nepopu-
njeno podacima. DrZite podatke Sto bliZe jedne drugima da biste Sto
bolje iskoristili raspolozivu memoriju racunara.

Kako se unose podaci

N

Osnovno pravilo za unoSenje podataka u radni list glasi (Citajte naglas):

Postavite pokaziva€ u onu celiju u koju podatak treba da bude
smesten, a zatim ga tu i upiSite.

Vodite racuna da Excel mora biti u rezimu rada Ready (spreman), to jest,
indikator Ready treba da se vidi na pocCetku statusne trake, pre nego Sto
pokuSate da postavite pokazivac u celiju. Kad pocnete da upisujete
podatak, Excel se prebaci u rezim rada Enter (a re¢ Enter zameni rec¢
Ready na mestu indikatora reZima programa na statusnoj traci).

Ako niste u reZimu Ready, pritisnite taster Esc.

Cim pocnete da upisujete podatke u rezimu Enter, znaci koje upisujete
pojavljuju se i u celiji na radnom listu i na traci za formule pri vrhu
ekrana. Kad pocCnete da upisujete nesto cCija je konacna sudbina da
ostane u tekucoj €eliji, u isto vreme izazivate i promene na traci za for-
mule, gde se pojavljuju dva nova dugmeta, Cancel i Enter, izmedu polja
za ime (u kome se nalazi adresa tekuce celije) i dugmeta Insert Function.

Kako nastavljate sa upisivanjem, Excel prikazuje vaSe napredovanje i na
traci za formule i u aktivnoj celiji na radnom listu (slika 2-1). Medutim,
pokazivac za unos teksta (vertikalna trepcuca linija koja sluZzi kao kursor
unutar Celije) vidi se samo na kraju znakova prikazanih u celiji.

Kada upiSete podatak treba i da ga postavite u celiju, tako da tamo

i ostane. Istovremeno, prebacicete program iz reZima Enter u rezim
Ready, tako da pokaziva€ moZete premestiti u drugu celiju, gde takode
moZete upisivati ili menjati neki podatak.

nnnnnnnnn
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]
Slika 2-1:
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Da biste zavrsili upisivanje podatka u €eliju, u isto vreme vrativsi Excel iz
reZzima Enter u reZim Ready, pritisnite dugme Enter na traci za formule,
pritisnite taster Enter na tastaturi ili jedan od tastera sa strelicama, na
primer |, 1, - ili —~ tako da se premestite u sledecu celiju. MoZete priti-
snuti i tastere Tab ili Shift+Tab i tako zavrsiti upisivanje podataka.

Medutim, iako sve ove alternative konacno postavljaju podatak u €eliju,
svaka od njih ima za nijansu drugaciji efekat, zato obratite paznju:

v Ako na traci za formule pritisnete dugme Enter (ono sa znakom
za potvrdu), podatak se smesta u celiju, a pokazivac Celije ostaje
u Celiji u kojoj se nalazi tek uneti podatak.

v’ Ukoliko pritisnete taster Enter na tastaturi, podatak se smesSta u
Celiju, a pokazivac celije se spusta u celiju ispod u sledecem redu.

v Ako pritisnete neki taster sa strelicom, podatak se smesta u celiju,
a pokazivac celije premesta se u susednu celiju u smeru strelice.
Ako pritisnete taster |, pokazivac celije premesSta se naniZe u sle-
dediniZi red, kao i kad pritisnete taster Enter na tastaturi. Medutim,
ako pritisnete taster —, pokazivac celije se premesta udesno u sle-
decu kolonu; ako pritisnete —, pokazivac celije premesta se ulevo,
u Celiju prethodne kolone; pritiskom na taster 1, pokazivac celije
premesta se naviSe, u €eliju u prvom redu iznad.

v Kada pritisnete taster Tab, podatak se smesta u celiju, a pokazivac
Celije premesta se u susednu celiju s desne strane (isto kao i kad
pritisnete taster —). Ako unesete podatak, a zatim pritisnete tastere
Shift+Tab, pokazivac celije se pomera u susednu celiju u prvoj
koloni s leve strane (isto kao i kad pritisnete taster ).

Bilo koji nac¢in da upotrebite za postavljanje upisa u €eliju, kada zavrSite
upisivanje podatka u tu celiju, Excel odmah deaktivira traku za formule i
uklanja dugmad Cancel i Enter. Podatak koji ste uneli u €eliju ostaje u njoj
i na radnom listu (sa izvesnim izuzecima o kojima ¢u govoriti kasnije u
ovom poglavlju), tako da svaki put kada pokazivac celije postavite u tu
Celiju, podatak se pojavi i na traci za formule.
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Poglavlje 2: Izrada radnog lista od samog pocetka

Ako tokom upisivanja podatka, ili nakon §to ste upisivanje zavrsili, a da
ga jos niste postavili u celiju, primetite da to nije celija u koju ste hteli da
ga postavite, moZete da obriSete i deaktivirate traku za formule pritiska-
njem dugmeta Cancel (ono sa znakom X) ili tastera Esc. U slucaju da to
primetite tek posto ste podatak postavili u celiju, moracete da preme-
stite podatak u drugu ¢eliju ili da ga obriSete (o ovim postupcima sazna-
cete u poglavlju 4), a zatim unesete podatak u odgovarajucu celiju.

Ima raznih tipova

WAL/

{EHN/G
Y,

Dok vi sre¢no i zadovoljno upisujete podatke u radne tabele, Excel bez
vaSeg znanja sve vreme analizira ono §to upisujete i klasifikuje podatke
kao jedan od tri moguca tipa: tekst, vrednost ili formula.

Kada Excel ustanovi da je upisana formula, on je automatski izracunava
i prikazuje izracunatu vrednost u €eliji na radnom listu (formula se i dalje
vidi na traci za formule). Ako Excel smatra da neki upis nije formula (dacu
koliko-toliko dobru definiciju formule kasnije u ovom poglavlju), prove-
rice da li upisani podatak treba klasifikovati kao tekst ili kao vrednost.

Excel pravi razliku izmedu teksta i vrednosti da bi znao kako da poravna
upise po Celijama. Tekstualne upise poravnava uz levu ivicu celije, a vred-
nosti uz desnu. Takode, posto vec¢ina formula daje dobre rezultate samo
ako ih hranite vrednostima, na osnovu toga sto pravi razliku izmedu
teksta i vrednosti program zna da li ¢e neki upis moci da se upotrebi

u formulama koje pravite. Dovoljno je zasad reci da ce vaSe formule
davati loSe rezultate ako za proracunavanje koriste sadrzaj iz celija u koje
je upisan tekst, a ne vrednost.

Podesavanje tastera Enter za postavljanje
pokazivaca ¢elije na mesto koje vam viSe odgovara

Excel automatski premeSta pokazivac celije
u prvu sledecu éeliju nanize u istoj koloni,
svaki put kada pritisnete taster Enter da
biste postavili podatak u ¢eliju. Ako Zelite da
prilagodite Excel tako da pritisak na taster
Enter ne pomera pokazivac celije, ili da ga
pomera naviSe, ulevo ili udesno, izaberite
Options u meniju Tools, a zatim izaberite kar-
ticu Edit u okviru za dijalog Options.

Ako hocete da se pokazivac celije uopste ne
premesta, uklonite znak potvrde opcije
Move Selection after Enter. Ako hocete da
se pokazivac ¢elije pomera u nekom drugom
pravcu, ostavite znak potvrde ali pritisnite
strelicu pored polja Direction, odmah ispod
opcije Move Selection after Enter, a zatim
izaberite pravac pomeranja (Right — desno,
Up —gore, Left—levo). Pritisnite dugme OKili
taster Enter da biste zatvorili okvir za dijalog.
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I
Slika 2-2:

Duzi tekst

se preliva u
susedne prazne
celije.

Pokazatelji koji otkrivaju da je re¢ o tekstu

Tekstualni upis je upis koji Excel ne moZe da klasifikuje ni kao vrednost ni
kao formulu. Tekst je dakle, sveobuhvatna kategorija podataka u Excelu.
Kao osnovno pravilo, smatrajte vec¢inu tekstualnih upisa (poznatih i kao
oznake - engl. labels) kombinacijama slova, znakova interpunkcije i bro-
jeva. Tekst se najviSe koristi za naslove, zaglavlja i napomene u radnom
listu.

Da je Excel upis klasifikovao kao tekst, neposredno se vidi po tome Sto ga
automatski poravna uz levu ivicu celije. Ako je tekstualni upis duZzi nego
Sto celija moZe da prikaZe, znaci ¢e se prelivati u susedne celije nadesno,
ali samo ukoliko su te celije prazne (slika 2-2).
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To znaci da ¢e Excel, ukoliko kasnije upiSete podatke u €eliju u kojoj se
vidi tekst preliven iz susedne celije, ukloniti preliveni tekst (slika 2-3).
Ne brinite: Excel u stvari ne briSe ovaj tekst — on samo ocisti prikaz na
ekranu kako bi napravio mesta za novi upis podataka. Ako hocete da
vidite iznenada ,,zagubljeni“ deo tekstualnog upisa, moracete da prosi-
rite kolonu u kojoj se nalazi celija koja ga sadrZi (ako hitno treba da
saznate kako se to radi, skoknite do poglavlja 3).

Kako Excel tumadi vrednosti

Vrednosti (engl. values) su osnovni elementi vecine formula koje pravite
u Excelu, a postoje dve sorte: brojevi koji predstavljaju koli¢ine (na pri-
mer, 14 spratova ili 140.000 evra) i brojevi koji predstavljaju datume
(na primer, 23. jun 2004) ili vreme (na primer, 14:00).

Znacete da je Excel prihvatio upis kao vrednost po tome Sto ¢e ga
poravnati nadesno. Ako je upis nesto duzi tako da ne moze u celosti da
bude prikazan u €eliji, Excel ¢e tu vrednost automatski prikazati (nista
manje nego) naucnom notacijom (engl. scientific notation) (na primer,
6E+08 oznacava cifru 6 pracenu sa osam nula, to jest, vrednost od 600
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Poglavlje 2: Izrada radnog lista od samog pocetka

Slika2-3: |

Upis podataka

uéelijena |!

desnoj strani
zaklanja
preliveni tekst.
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miliona). Da biste vratili vrednost iz ove neobi¢ne nauc¢ne notacije u
obican broj, prosirite kolonu u kojoj se doti¢na celija nalazi (objaSnjeno
u poglavlju 3).
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Proverite da i je Excel prihvatio uneti broj

Prilikom izrade radnog lista verovatno najveci deo vremena provodite
u upisivanju brojeva koji predstavljaju sve moguce vrste koliCina, od
za kafu i krofne (hocete da kaZete kako u vasoj kancelariji ne dobijate
krofne?).

TEHNIG,

MozZete iskoristiti indikator AutoCalculate da  tako da obuhvatite i oznacite obe celije
proverite kako Excel svim tekstualnim upisi- (i ¢eliju sa malopre upisanim brojem 101 ¢eli-
ma dodeljuje vrednost 0 (nula). UpiSite u éeli-  ju sa tekstom). Zatim bacite pogled na indika-
ju broj, recimo 10, a u prvu éeliju ispod upiSite  tor AutoCalculate i videcete da pokazuje
bilo kakav tekst, recimo ,Excel je kao kutija SUM=10, $to znaéi da tekst ne ucestvuje
cokolade”. Zatim povlacite miSa iz te ¢elije  u ukupnom zbiru vrednosti ovih dveju ¢elija.

Za Excel je tekst samo jedna velika nula

Da biste upisali numericku vrednost koja predstavlja pozitivhu kolicinu,
na primer, novac koji ste zaradili prosle godine, izaberite neku celiju,
upiSite broj — na primer, 459600 - i postavite taj upis u celiju tako sto
Cete pritisnuti taster Enter, dugme Enter na traci za formule itd. Da biste
upisali numericku vrednost koja predstavlja negativnu koli€inu, recimo
novac utroSen za kafu i krofne tokom prosle godine, pre upisivanja cifara
upis zapocnite znakom minus (-), to jest, znakom za rastavljanje reci, na
primer -175 (bas se i niste pretrgli kad su u pitanju kafa i krofne, pored
zarade od €459600), a zatim zavrSite upis.
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60 Deo I: Ulazak na osnovni nivo

Ako ste ucili racunovodstvo, negativan broj (to za vas predstavljatrosak)
mozZete zatvoriti u zagrade: (175). Samo da znate, i pored sveg truda da
svoje negativne brojeve (troSkove) zatvorite u zagrade, Excel ce ih
automatski pretvoriti u brojeve koji pocinju znakom minus; znaci, kada
upiSete (175) u Celiju za kafu i krofne, Excel vam uzvrati sa-175 (ne mari,
u poglavlju 3 objasni¢u vam kako da vratite svoje omiljene zagrade).

Numerickim vrednostima koje predstavljaju novCane iznose, kao sto je
koli¢ina novca koju ste zaradili prosle godine, moZete dodati znak za
valutu i tacke (.) za razdvajanje hiljada, isto kao i u Stampanim ili pisanim
brojevima. Vodite racuna o tome da kada upisujete brojeve s tackama,
Excel na te vrednosti primenjuje numericki format koji je u skladu s naci-
nom na koji koristite tacke i zareze (detaljnije objasnjenje o numerickim
formatima i njihovoj upotrebi potrazite u poglavlju 3). Sliéno tome, kada
ispred neke finansijske vrednosti stavite znak za dolar (ili iza vrednosti
upiSete din), Excel primenjuje odgovarajuci valutni brojevni format na tu
vrednost (koji automatski ubacuje znake za razdvajanje hiljada).

Kada upisujete brojcane vrednosti s decimalnim mestima, upotrebite
zarez za odvajanje celih od decimalnih mesta. Prilikom upisivanja vred-
nosti manjih od jedan, Excel automatski prikazuje nulu ispred decimal-
nog zareza (Excel ¢e ubaciti 0,34 tamo gde vi upiSete ,34) i odbaciti
nepotrebne nule u decimalnim mestima (Excel ¢e ubaciti 12,5 tamo
gde vi upiSete 12,50).

Ako ne znate decimalni ekvivalent vrednosti koja sadrzi razlomak, slo-
bodno upiSite razlomak onakav kakav jeste. Na primer, ako ne znate da je
2,1875 decimalni ekvivalent razlomka 2 3/16, jednostavno upisite u céeliju
2 3/16 (obavezno ostavite jedan razmak izmedu 2 i 3). Po kompletiranju
upisa, kada postavite pokazivac €elije u tu celiju, na radnom listu cete
videti 2 3/16 ali ¢e u polju za formule biti broj 2,1875. Kao 5to cete videti
u poglavlju 3, sasvim je prost trik da se formatira prikaz broja2 3/16 u
Celiji tako da se izjednaci sa 2, 1875 u polju za formule.

Napomena: Ne zaboravite da pri upisivanju pravih razlomaka, kao sto
su 3/4 ili °/8, morate ispred njih dopisati nulu; na primer, 0 3/4 ili 0 5/8
(obavezno ubacite razmak izmedu nule i razlomka). U suprotnom, uko-
liko na racunaru imate podeSen americki format datuma, Excel ¢e pomi-
sliti da upisujete datume 3. apr (3/4) i 5. avg (5/8).

Kada upisujete broj¢ane vrednosti koje predstavljaju procente (stote
delove), moZete da birate:

v MozZete da podelite broj sa 100 i da upiSete decimalni ekvivalent
(pomerajuci decimalni zarez za dva mesta ulevo, kao §to ste ucili
u Skoli; na primer, upiSite ,12 za 12 procenata).

v MozZete da upiSete broj dodavsi mu znak za procenat (na primer,
upiSite 12%).
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Poglavlje 2: Izrada radnog lista od samog pocetka

Ma Sta da izaberete, Excel c¢e u €eliju upisati decimalni broj (u ovom slu-
Caju 0,12). Ako koristite znak za procenat, Excel ¢e na vrednost u rad-
nom listu primeniti procentni format brojeva, i ona ce se pojaviti kao 12%.

Kako da fiksirate broj decimalnih mesta (¢ak i kad ne znate
da je razliéit od broja do broja)

Kada treba da unesete Citav niz brojeva koji svi treba da imaju isti broj
decimalnih mesta, moZete aktivirati Excelovu opciju Fixed Decimal, pro-
gram ¢e sam kontrolisati broj decimalnih mesta umesto vas. Ovo je vrlo
prakticno kada treba upisati, recimo, stotine finansijskih brojki koje sve
imaju po dva decimalna mesta.

Da biste fiksirali broj decimalnih mesta u numerickim upisima, uradite
sledece:

1. Izaberite Tools => Options s linije menija.
Otvara se okvir za dijalog Options.

2. Izaberite karticu Edit u okviru za dijalog Options.

3. Postavite znak za potvrdu u polje pored opcije Fixed Decimal.
Po pravilu, Excel fiksira broj decimalnih mesta na dva, i to ulevo od
poslednje cifre koju upiSete. Ako hocete da promenite podrazume-
vani broj decimalnih mesta, predite na korak 4. U suprotnom, pre-
dite na korak 5.

4. Upisite broj decimalnih mesta u polje Places, ili upotrebite dug-
mad brojaca da biste promenili vaZecu vrednost.

Na primer, vrednost u polju Places moZete promeniti na 3 da biste
upisivali brojeve sledeceg formata: 00,000

5. Pritisnite dugme OK, ili taster Enter.

Excel ¢e aktivirati indikator FIX na statusnoj traci, tako da ¢ete znati
kada je opcija Fixed Decimal aktivna.

Nakon fiksiranja broja decimalnih mesta za numericke vrednosti, Excel
¢e automatski dodavati decimalni zarez svakoj numerickoj vrednosti
koju upiSete — vi treba samo da upiSete cifre i da kompletirate upis u
Celiju. Na primer, ako hocete da u celiju upiSete broj 100,99 nakon Sto ste
fiksirali broj decimalnih mesta na 2, upisite cifru 10099, ne upisujuci pri
tom decimalni zarez. PoSto kompletirate upis u €eliju, Excel ¢e automatski
upisati decimalni zarez dva mesta zdesna u broju koji ste upisali, ostavlja-
juci u €eliji broj 100,99.

Kada hocete da koristite normalan nacin upisivanja numerickih vred-
nosti (tj. kada sami upisujete decimalna mesta), otvorite okvir za dijalog
Options, izaberite karticu Edit, uklonite znak za potvrdu pored opcije
Fixed Decimal, a zatim pritisnite dugme OK ili taster Enter. Excel ¢e
ukloniti indikator FIX sa statusne trake.
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62 Deo I: Ulazak na osnovni nivo

Kucanje po kasi

Prakticniji nacCin za koriScenje opcije Fixed Decimal jeste da izaberete
blok celija u koje cete upisivati brojeve (pogledajte odeljak ,Upisivanje
podataka u blokove ¢elija“ kasnije u ovom poglavlju) i da pritisnete
taster Num Lock. Tada sve brojeve za tu grupu cCelija moZete da unesete
s numerickog dela tastature (po izgledu podseca na tastature koje

ghLJI

<,

"EHNI‘-:f/

moZete videti na kasama u prodavnicama).

Ne dajte da vas zbune decimalna mesta

Dok je opcija Fixed Decimal aktivna, Excel
ubacuje decimalni zarez u sve brojeve koje
upiSete. Medutim, ako u radni list hoéete da
unesete broj bez decimalnih mesta, ili da
upiSete vrednost Ciji je broj decimalnih
mesta drugadiji od fiksiranog, morate sami
da upiSete decimalni zarez. Na primer, ako
je broj decimalnih mesta fiksiran na dva, u

je obavezan) ako hocete da unesete broj
1099 umesto broja 10,99.

I, za ime BoZje, ne zaboravite da iskljucite
opciju Fixed Decimal pre nego $to pocnete
da radite na drugom radnom listu i pre nego
$to napustite Excel. U suprotnom, kada bu-
dete hteli da upiSete neku vrednost kao $to
je 20, dobicete 0,2 a nec¢e vam hiti jasno Sta

celiju treba da upiSete 1099, (zarez iza broja se dogadal

Ako upotrebite ovaj Stos, moci ¢ete brzo da upiSete gomilu brojeva u
izabrane Celije upisivanjem broja u ¢€eliju i pritiskanjem tastera Enter
(kao na kasi). Excel ¢e postaviti decimalni zarez gde treba i pomeriti
pokazivac Celije u sledecu niZu celiju. Jos bolje, kada popunite jednu
kolonu, pritisnite taster Enter da biste premestili pokazivac celije na vrh
sledece kolone u izabranom bloku celija, a ne u sledecu niZu celiju.

Na slikama 2-4 i 2-5 prikazano je kako ova tehnika radi. Na slici 2-4, opcija
Fixed Decimal je aktivna (sa podrazumevana dva decimalna mesta), i
izabran je blok celija od B3 do D9. Na slici se takode vidi da je vec¢ upi-
sano Sest brojeva u celije od B3 do B8, i da ¢e upis u susednu €eliju, broj
30834,63 upravo biti kompletiran. Da biste upisali ovaj broj s numericke
tastature dok je aktivna opcija Fixed Decimal, na numerickoj tastaturi
otkucajte 3083463.

Na slici 2-5, prikazano je Sta se dogada poSsto pritisnete taster Enter (bilo
koji od dva). Kao §to vidite, Excel ne samo $to dodaje decimalni zarez

u vrednost u polju B9, vec¢ i pomera pokazivac celije navise i udesno

u Celiju C3, tako da moZete nastaviti upisivanje brojeva za tu kolonu.
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Poglavlje 2: Izrada radnog lista od samog pocetka
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Slika 2-4: |

Da biste upisali |
vrednost |
30834,63 |

u éeliju B9, |
otkucajte |
3083463 i |
pritisnite Enter. |
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Slika 2-5: W Pl LR X TP

Kada pritisnete
Enter za
postavljanje
vrednosti
30834,63

u éeliju B9,
program
automatski
premesta |
pokazivat |

u celiju C3. | 5

& = T

[1]

¥ ki !
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Unosenje datuma bez diskusije

Na prvi pogled, moze vam izgledati cudno Sto se u Excelu datumi i vreme
unose kao vrednosti u celije radnog lista, a ne kao tekst. Razlog za to je
sasvim jednostavan, zaista: datumi i vremena uneti kao vrednosti mogu
se upotrebiti u formulama za izracunavanja, dok datumi i vremena uneti
kao tekst ne mogu. Na primer, ako unesete dva datuma kao vrednosti,
moZete napisati formulu koja ¢e izracunavati broj dana izmedu ta dva

datuma. Takav proracun se ne moze izvesti ako su datumi uneti kao tekst.

Excel odreduje da li je datum ili vreme koje upiSete unet kao vrednost ili
tekst na osnovu formata kog se pridrzavate. Ako se pridrzavate jednog
od Excelovih ugradenih formata za datum i vreme, program c¢e prihvatiti
datum i vreme kao vrednosti. Ako se ne pridrzavate ovih formata, pro-
gram ce upisane podatke tretirati kao tekst.
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64 Deo I: Ulazak na osnovni nivo

Excel prepoznaje sledece formate za vreme:

3 AM ili PM

3 Aili P (za AP i PM)
3:21 AM ili PM

3:21:04 AM ili PM

15:21

15:21:04

Excel prepoznaje sledece formate datuma (skracenice za mesece u
godini uvek se sastoje od prva tri slova u nazivu meseca, na primer,
Jan, Feb, Mar...):

November 6, 2003 ili November 6, 03
11/6/03 ili 11-6-03
6-Nov-04 ili 6/Nov/04 ili cak 6Nov04

11/6 ili 6-Nov ili 6/Nov ili cak 6Nov

AL

<,

TEHNIG,

Nov-04 ili Nov/04 ili Nov04

Igra s datumima

Datumi se skladiSte kao redni brojevi koji
pokazuju koliko je dana proteklo od odre-
denog pocetnog datuma; vremena se skla-
diSte kao decimalni brojevi koji pokazuju
protekli deo dvadeset¢etvorocasovnog pe-
rioda. Excel podrZava dva sistema za datu-
me: sistem datuma 1900 koji koristi Excel za
Windows, gde je 1. januar 1900 pocetni
datum (redni broj 1) i sistem 1904 koji koristi
Excel za Macintosh, u kome je 2. januar 1904
usvojen kao pocetni datum.

Ako naidete na radnu svesku uradenu u Ex-
celu za Macintosh i, poSto je otvorite, vidite
datume koji izgledaju nekako uvrnuto, ot-
kloniéete taj problem ako iz menija Tools iza-
berete Options, zatim izaberete karticu Cal-
culation u okviru za dijalog Options, a zatim u
grupi opcija Workbook potvrdite opciju 1904
Date System i pritisnete dugme OK.

Datumi u 21. veku

Suprotno onome §to mozda mislite, kada unosite datume u 21. veku,

dovoljno je da unesete samo poslednje dve cifre iz broja godine. Tako,
na primer, da biste u radni list uneli datum 6. januar 2004, dovoljno je da
u Celiju upiSete 6.1.04. Ili, ako Zelite da unesete datum 15. februar 2010,
u Celiju upisite samo 15.2.10.
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Poglavlje 2: Izrada radnog lista od samog pocetka

N

Obratite paznju na to da sistem dvocifrenog upisivanja datuma za 21. vek
vaZi samo za prve tri decenije, odnosno za godine od 2000. do 2029.
Pocev od 2030. morate upisivati sve Cetiri cifre.

Medutim, ako unosite datume za prve tri decenije 20. veka (od 1901 do
1929), morate uneti sve Cetiri cifre. Na primer, 21. jul 1925. upisacéete u
Celiju kao 21.7.1925. S druge strane, ako unesete samo dve poslednje
cifre (25) za godinu, Excel ¢e uneti godinu 2025. umesto 1925!

Excel 2003 u €eliji i na traci za formule uvek prikazuje sve Cetiri cifre
broja godine, ¢ak i ako upiSete samo poslednje dve cifre. Na primer, ako
u Celiju unesete 11.06.04, Excel ¢e automatski prikazati 11.06.2004

(u €eliji i na traci za formule za tu celiju).

Na taj nacin uvek cete znati da li ste uneli datum koji se odnosi na 20. ili
21. vek, cak i ako se ne pridrzavate glupih pravila koja odreduju kada se
unose dve, a kada Cetiri cifre (u poglavlju 3 potrazite dodatne informacije
o formatiranju €elija u koje su upisani datumi, tako da se na radnom listu
pojavljuju samo poslednje cifre).

Da biste saznali kako se obavljaju jednostavne aritmeticke operacije s
datumima i vremenom koje ste uneli na radni list, a da rezultat na kraju
ima nekog smisla, potrazite odeljak o datumima u poglavlju 3.

Evo kako se prave te famozne formule!

Formule su stvarna snaga radnih listova. Ako ih pravilno koristite,
izraCunace tacnu vrednost vec pri prvom upisivanju u €eliju. Nadalje,
izraCunata vrednost bice automatski aZurirana, to jest, ponovo izracu-
nata, kad god promenite neku od vrednosti koje formula koristi.

Excelu najavljujete nameru da u tekucu €eliju upiSete formulu (a ne tekst
ili vrednost), tako Sto cete prvo upisati znak jednakosti (=). Najjednosta-
vnije formule sastoje se od znaka jednakosti i neke od ugradenih funkcija,
kao Sto su SUM ili AVERAGE. (Procitajte tekst ,Ubacivanje funkcije u for-
mulu pomocu dugmeta Insert Function®, kasnije u ovom poglavlju, da
biste saznali detalje o upotrebi funkcija u formulama.) Ostale jednosta-
vnije formule sastoje se od nizova vrednosti (ili referenci Celija u kojima
su upisane vrednosti), razdvojenih pomocu jednog ili viSe matematickih
operatora:

+ (plus) za sabiranje

- (minus) za oduzimanje
* (zvezdica) za mnoZenje
/ (kosa crta) za deljenje

A (kapica) za stepenovanje
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66 Deo I: Ulazak na osnovni nivo

Na primer, da biste u celiji C2 imali vrednost koja predstavlja umnozak
vrednosti u €eliji A2 i vrednosti u €eliji B2, u €eliju C2 treba da postavite
sledecu formulu: =A2*B2.
Da biste ovu formulu postavili u €eliju C2, uradite sledece:

1. Izaberite celiju C2.

2. Upisite celu formulu =A2*B2 u ¢eliju.

3. Pritisnite Enter.

1li
1. Izaberite celiju C2.
2. UpiSite = (znak jednakosti).
3. Izaberite éeliju A2 na radnom listu pomocu misa ili tastature.

Ovaj korak postavlja referencu celije A2 u formulu (kao §to je prika-
zano na slici 2-6).

{Eliullulﬂlii-ridn .
A fillr [l e i Fesd (sl [els eeiee e -
] - . L - a E i i HL ;
ld o, L |
A B c D F F=
1
2 | 20| 100[=A2
3 aa
i
4]
G
i
]
B
Slika 2-6: =
Upisivanje =
formule poénite | T
znakom 11
jednakosti (=),
azatim | 1.2 i
izaberite [® ® ¢ P el SShweta i li o
celiju A2.

= | B =

4. UpiSite * (Shift+8 u gornjem redu tastature).
Za mnoZenje se Koristi zvezdica umesto znaka x koji ste koristili
u Skoli.

5. Izaberite celiju B2 na radnom listu pomocu misa ili tastature.
Ovaj korak postavlja referencu celije B2 u formulu (slika 2-7).

003N, August 3, 2004 10:29 am

A CAAN €m £ et



Poglavlje 2: Izrada radnog lista od samog pocetka
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Slika 2-7:
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6. Pritisnite dugme Enter na traci za formule da biste kompletirali
upisivanje formule, ostavivsi u isto vreme pokazivac u celiji C2.
Excel ¢e izracunatu vrednost ispisati u €eliji C2, a formulu =A2*B2
u polju za formule (slika 2-8).

(5] =dinak e - pmlrt =
D) e gl e Dt Poressk ewis  Dels e s ]
. = | HErh | el LA | - -
. i =BT
[ A a8 € | D E F =
.1
(2] 20 1o0[__2000]
3 4
42
2|
6 |
| -|r
Slika28: | g
Kada pritisnete =1
dugme Enter, E |
Excel prikaze | 1[I
rezultat u celiji 1;t'
C2, aformula |
sepojavi | 12
upoljuza |= = v s e bt £ Sa |4 |
formule. et

— et 81 IR

Ll L
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68 Deo I: Ulazak na osnovni nivo

Kada upiSete formulu =A2*B2 u celiju C2 na radnom listu, Excel prika-
zuje izraCunati rezultat koji zavisi od tekucih vrednosti u celijama A2 i
B2. Najvecu vrednost elektronskih proracunskih tabela predstavlja bas
mogucnost da formule automatski izracunaju nov rezultat u trenutku
kada se promene vrednosti u ¢elijama na koje upucuju reference upisane
u formule.

Sad dolazi zabavni deo: posto upiSete formulu, recimo onu §to smo malo-
Cas pomenuli i koja sadrZi reference na vrednosti u nekim celijama (a ne
same vrednosti), moZete menjati vrednosti u tim celijama, a Excel e
automatski ponovo uraditi proracun prema toj formuli, koristeci nove
vrednosti i prikazati azurirani rezultat na radnom listu! Koristeci primer
prikazan na slici 2-8, pretpostavimo da Zelite da promenite vrednost u
celiji B2 sa 100 na 50. U trenutku kada unesete ovu promenu u €eliju B2,
Excel ¢e preracunati formulu i prikazati nov rezultat, 1000, u celiji C2.

Ako je hodete, samo pokaZite

Metoda odabiranja celija koje c¢e biti upotrebljene u nekoj formuli
umesto upisivanja njihovih referenci neposredno u formulu, u stvari je
direktno pokazivanje (engl. pointing) na ¢eliju. Ova metoda je ne samo
brza od upisivanja referenci na celije, ve¢ i smanjuje rizik upisivanja
pogresnih referenci. Prilikom upisivanja, moZe vam se lako desiti da
upiSete pogresno slovo kolone ili pogreSan broj reda i da ne primetite
gresku koju ste napravili.

Ako €eliju koju hocete da upotrebite u formuli izaberete pomocu misa
ili premeStanjem pokazivaca celije u nju, smanjujete mogucénost da u for-
mulu unesete referencu pogresne celije.

Izmena prirodnog redosleda operacija

Mnoge formule koje pravite obavljaju viSe od jedne matematicke opera-
cije. Excel izvr§ava svaku operaciju, krecuci se sleva nadesno, u skladu
sa strogim pravilima prirodnog redosleda aritmetickih operacija. U ovom
redosledu, operacije mnoZenja i deljenja imaju prednost u odnosu na
sabiranje i oduzimanje i shodno tome prve se izvrSavaju, ¢ak i kada se
ne nalaze na prvom mestu u formuli (Citajuci sleva nadesno).

Razmotrimo niz operacija u sledecoj formuli:
=A2+B2*C2

Ako celija A2 sadrZi broj 5, B2 broj 10 a C2 broj 2, Excel ¢e racunati prema
sledecoj formuli:

=5+10*2
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U ovoj formuli, Excel mnoZi 10 sa 2, Sto je jednako 20 i zatim dodaje tom
rezultatu broj 5, Sto daje konacan rezultat 25.

Ako hocete da Excel prvo sabere vrednosti u ¢elijama A2 i B2, a zatim da
taj zbir pomnoZzi sa vrednoscu u €eliji C2, onda operaciju sabiranja
zatvorite u zagrade:

=(A2+B2)*C2

Zagrade oko operacije sabiranja upucuju Excel da ovu operaciju treba da
obavi pre operacije mnoZzenja. Ako celija A2 sadrZi broj 5, B2 broj 10, a C2
broj 2, Excel sabira 5i 10, Sto je jednako 15, a zatim taj zbir mnozi sa 2,
Sto kao konacan rezultat daje 30.

U sloZenijim formulama, treba da dodate viSe od jednog para zagrada,
stavljajudi ih jedne unutar drugih (kao one ruske drvene lutke koje se
stavljaju jedna u drugu) da biste precizirali redosled kojim ce se izvrSa-
vati operacije. Kod tako ugneZdenih zagrada, Excel prvo izvrSava opera-
cije obuhvacene unutrasnjim zagradama, a potom njihov rezultat koristi
u daljim operacijama. Na primer, razmotrimo sledecu formulu:

=(A4+(B4-C4))*D4

Excel najpre oduzima vrednost u €eliji C4 od vrednosti u Celiji B4, zatim tu
razliku dodaje vrednosti u Celiji A4 i najzad taj zbir mnoZzi sa vrednoSc¢u u
Celiji D4.

Ako bi u gornjoj formuli zagrade izostale, prepusten sam sebi, Excel bi
prvo pomnoZio vrednosti u ¢elijama C4 i D4, zatim bi tako dobijenu vred-
nost oduzeo od zbira vrednosti u ¢elijama A4 i B4.

Ne brinite ako prilikom gneZdenja ne uparite paZzljivo zagrade u formulama
da biste svakoj otvorenoj (levoj) zagradi obezbedili i zatvorenu (desnu)
zagradu. Ako ne zatvorite zagradu, Excel ¢e prikazati okvir za dijalog s
predlogom Sta treba uraditi da bi se ispravila greska i postigla ravnoteza
izmedu parova. Ako prihvatate predlog, pritisnite dugme Yes. Obavezno
koristite samo obicne zagrade: (). Excel u formulama nedozvoljava
korisc¢enje uglastih — [ ] - ili viticastih — { } — zagrada i to vam signalizira
otvaranjem okvira s porukom o gresci.

Grube greske u formulama

Pod izvesnim okolnostima, ¢ak i najbolje napisane formule se razgoropade
u trenutku kad ih postavite na radni list. Umesto lepo izracunate vrednosti
ugledacete cudnu i nerazumljivu poruku, ispisanu velikim slovima, koja
pocinje simbolom za broj (#), a zavr§ava se uzvicnikom (!), au jednom
slucCaju i upitnikom (?). Ove neobicCne pojave poznate su, u recniku radnih
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tabela, pod imenom vrednost greSke (engl. error value). Svrha njihovog
postojanja je da vas obaveste kako neki element — bilo usamom polju za
formule, bilo u celiji na koju se referenca formule odnosi — sprecava
Excel da kao rezultat da pretpostavljenu izracunatu vrednost.

U slucaju da neka formula ima vrednost greske, levo od €elije u kojoj se
nalazi pokazivac celije pojavice se indikator upozorenja (uzvi¢nik u trou-
glu), a u gornjem levom uglu Celije videcete mali zeleni trougao. Kada
postavite pokaziva¢ miSa na ovaj indikator upozorenja, Excel ¢e prikazati
kratak opis greSke formule i odmah desno pored okvira dodace dugme
sa strelicom nadole. Ako pritisnete ovo dugme, pojavice se pomo¢ni
meni koji ¢e vam ponuditi nekoliko opcija. Da biste dobili pomo¢ u vezi

s greSkom formule, kao i predloge kako da ispravite gresku, izaberite
stavku Help on This Error iz pomoc¢nog menija.

Najgore je to Sto se vrednosti greSke lako Sire i na ostale formule radnog
lista. Ako jedna formula rezultira vrednosc¢u greske, a formula u drugoj
Celiji sadrzi referencu na vrednost izraCunatu prvom formulom, i druga
formula ¢e kao rezultat imati istu vrednost greske, i tako redom.

Kada se u €eliji pojavi vrednost gresSke, morate da ustanovite njen uzrok
i popravite formulu. U tabeli 2-1 navedene su vrednosti greSaka na koje
Cete verovatno naici, kao i objasnjenja najcescih uzroka.

Tabela 2-1 Vrednosti greSaka na koje cete naici u nepravilnim

formulama
U celiji Sta se tu dogada?
se pojavljuje
#DIV/0! Pojavljuje se kada formula trazi deljenje éelijom koja sadrzi vred-

nost0, ili, Sto je €eSéi slucaj, ¢elijom koja je prazna. Deljenje nulom
nije dozvoljeno u matematici.

#NAME? Pojavljuje se kada formula sadrZi referencu na ime podrucja
(u poglavlju 6 potraZite obavestenja o imenovanju podrucja celija)
koje ne postoji na radnom listu. Ova vrednost greske pojavljuje se
kada upiSete pogreSno ime podrucja ili kad tekst koji se pojavljuje
u formuli ne stavite izmedu navodnika, tako da ga Excel smatra za
referencu na ime podrugja.

#NULL! Najées$ce se javlja kad umetnete razmak (tamo gde treba da se
nade tacka i zarez) da biste razdvoijili reference celija koje sluze
kao argumenti u funkcijama.

#NUM! Javlja se kad Excel naide na problem s brojem u formuli, na primer,
na pogreSan tip argumenta u funkciji, ili kad je rezultat izracuna-
vanja toliko veliki (odnosno mali) broj da se ne moZe predstaviti na
radnom listu.
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Poglavlje 2: Izrada radnog lista od samog pocetka

Tabela 2-1 Vrednosti greSaka na koje ¢ete naici u nepravilnim
formulama (nastavak)

U éeliji Sta se tu dogada?
se pojavljuje
#REF! Pojavljuje se kad Excel naide na pogre$nu referencu celije, na

primer, ako izbriSete éeliju na koju se odnosi referenca u formuli,
ili kad iskopirate nove ¢elije preko celija za koje ve¢ postoji refe-
renca u datoj formuli.

#VALUE! Pojavljuje se pri upotrebi argumenta pogreSnog tipa i pri upotrebi
pogresnog operatora u funkciji ili kad zahtevate matematicku
operaciju nad ¢elijama koje sadrZze samo tekstualne upise.

Ispravijanje grubih gresaka prilikom
unosenja podataka

Svi Zelimo da budemo bezgresni, ali avaj, malo je takvih medu nama.
Najbolje Sto moZemo da uradimo jeste da se pripremimo za neizbeZan
trenutak kada shvatimo da smo zabrljali. Kada unosite velike koliCine
podataka, nestasne grescCice u kucanju sasvim se lako uvuku u vas rad.
U naporu da izradite savrSen radni list, moZete uraditi nekoliko stvari:
kao prvo, pomocu opcije AutoCorrect podesite Excel da automatski
ispravlja daktilografske greske, u trenutku kada se i dogode; drugo,
svojerucno i odmah ispravljajte sve greske u kucanju koje se provuku,
bilo dok podatak upisujete ili nakon Sto ste ga postavili u celiju.

AutoCorrect radi za vas

Opcija AutoCorrect je bogomdana za sve nas koji uporno ponavljamo
iste greske prilikom kucanja. Pomocu ove opcije skrenucete Excelu 2003
paznju na svoje uobicCajene greSke u kucanju i objasniti mu kako da ih
automatski ispravlja umesto vas.

Odmah posto instalirate Excel, opcija AutoCorrect ve¢ zna da treba auto-
matski da ispravi dva uzastopna velika slova na pocetku reci (zamenjujuci
drugo veliko slovo malim slovom), da nazive dana u nedelji (na engleskom
jeziku) ispiSe velikim slovom na pocetku reci i da zameni izvestan broj tek-
stualnih upisa i tipografskih greSaka unapred zadatim tekstom.

Spisak tekstualnih upisa koji ¢e automatski biti zamenjeni unapred zada-
tim tekstom moZete dopunjavati tokom rada, kad god vam to zatreba.
Tekst za zamenu mozZe biti dvojak: tekst za zamenu uobicajenih tipograf-
skih gresaka i tekst u punom obliku kojim se zamenjuju skracenice i akro-
nimi koje Cesto kucate.
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Dopuna spiska skracenica i greSaka izgleda ovako:

1. S linije menija izaberite Tools => AutoCorrect Options. Pojavice
se okvir za dijalog AutoCorrect.

2. Na kartici AutoCorrect ovog okvira za dijalog, u polje Replace
upiSite tipografsku greSku, odnosno skracenicu.

3. Upisite ispravku, odnosno ceo tekst u polje With.

4. Pritisnite dugme Add (ili taster Enter) da biste novu ispravku,
odnosno skracenicu uveli u spisak opcije AutoCorrect.

5. Pritisnite dugme OK da biste zatvorili okvir za dijalog
AutoCorrect.

Pravila ponasanja prilikom uredivanja celija
Uprkos pomocdi opcije AutoCorrect, neke greske necete izbeci. Kako cete
ih ispravljati zavisi od toga da li ste ih primetili pre ili nakon upisivanju

podataka u celiju.

v Ako greSku primetite pre postavljanja upisa u celiju, moZete je
ukloniti pritiskanjem tastera Backspace (taster koji se nalazi odmah
iznad tastera Enter) onoliko puta koliko je potrebno da iz Celije
izbriSete pogreSno upisane znakove. Zatim upiSite ono Sto treba
i postavite upis u celiju.

v Ukoliko greSku primetite odmah poSto postavite upis u celiju, upis
moZete ili kompletno zameniti, ili ispraviti samo pogresSno unete
znakove.

v Kada su u pitanju kratki upisi, verovatno cete se opredeliti za
kompletnu zamenu. Postavite pokazivac celije u celiju s greSkom,
unesite ispravan sadrZaj i postavite ga u celiju pritiskom na dugme
Enter, taster Enter, ili na jedan od tastera sa strelicama.

v Kada je greSka srazmerno mala, a upis nesto duZi, bice jednostav-
nije da greSku ispravite uredivanjem sadrZaja celije umesto pot-
punom zamenom. Pritisnite dvaput celiju ili je izaberite na neki
drugi nacin, a zatim pritisnite taster F2.

v Svaki od ovih postupaka aktivirace traku za formule: na njoj ¢e se
pojaviti dugmad Cancel i Enter uz istovremeno postavljanje poka-
zivac€a za unos teksta (kursora) u €eliju na radnom listu. (Tamo gde
pritisnete dvaput miSem, tu cete postaviti kursor, ako pritisnete F2,
kursor se smesta iza poslednjeg znaka u celiji.)

v Takode, obratite paznju na to da se i indikator rezima rada menja i
da sada na njemu piSe Edit. U ovom reZimu moZete upotrebiti miSa
ili tastere sa strelicama da biste premestili kursor na odgovarajuce
mesto u Celiji.
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U tabeli 2-2 dat je spisak kombinacija tastera za premestanje kursora po
Celiji. Ako hocete da upiSete nove znakove na mestu kursora, jednostavno
pocnite da upisujete. Ukoliko hocete da upiSete nove znakove uz istovre-
meno brisanje postojecih, pritisnite taster Insert kako biste iz normalnog
reZima rada (umetanje teksta) presli u reZim upisivanja teksta preko pos-
tojeceg. Da biste se vratili u uobicajen rezim rada sa umetanjem teksta,
jos jednom pritisnite taster Insert. Kada unesete ispravke u celiju, morate
da pritisnete Enter da bi Excel aZurirao sadrzaj te celije.

Prica o dva uredivanja: uredivanje unutar celije
i uredivanje u polju za formule

Excel omogucuje da birate izmedu ure-
divanja sadrZaja celije u samoj celiji (Sto je
upravo objasnjeno) i uredivanja u polju za
formule. Dok je uredivanje u ¢eliji u veéini
sluajeva sasvim zadovoljavajuée reSenje,
kada se radi o zaista dugackim upisima (na
primer, dugackim formulama ili tekstovima
koji se sastoje od nekoliko pasusa), bice
vam lakse da to uradite u polju za formule.
Razlog za to je Sto Excel moZe da proSiri

neophodno da bi se prikazao celokupan
sadrzaj celije; u prikazu na radnom listu,
medutim, sadrzaj éelije moZe da se protegne
i preko dimenzija ekrana.

Da biste sadrzaj éelije uredivali u polju za
formule, a ne u samoj celiji, morate postaviti
pokaziva¢ u éeliju Ciji sadrzaj hodete da
menjate i zatim dvaput pritisnuti miSem na
neko mesto u polju za formule (najbolje blizu
mesta na kome se nalazi deo sadrzaja celije

polje za formule u onoliko redova koliko je koji hodate da ispravite).

Tabela 2-2 Tasteri za ispravljanje greSaka u celiji

Taster(i) Sta kombinacija tastera radi

Delete BriSe prvi znak desno od kursora

Backspace  BriSe prvi znak levo od kursora

- Pomera kursor za jedan znak udesno

- Pomera kursor za jedan znak ulevo

1 Postavlja kursor, kada se ovaj nade na kraju ¢elije, na njegovu
prethodnu poziciju ulevo

Endili ¢ Postavlja kursor iza poslednjeg znaka u ¢eliji

Home Postavlja kursor ispred prvog znaka u ¢éeliji

Ctrl+ - Postavlja kursor na pocetak sledece reci u celiji

Ctrl+ Postavlja kursor na pocéetak prethodne reci u ¢eliji

Insert Prebacuje iz reZima umetanja teksta u rezim pisanja preko

postojeceg teksta
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Dok je Excel u rezimu rada Edit, izmenjen sadrZaj u celiju postavicete pri-
tiskom dugmeta Enter ili tastera Enter. Tastere sa strelicama mozZzete kori-
stiti za kompletiranje upisa u €eliju samo kad je program u reZimu rada
Enter. Dok je program u rezimu Edit, tasteri sa strelicama samo pomeraju
kursor po Celiji koju uredujete, i ne mogu ga premestiti u drugu celiju.

Izbegavanje monotonije pri upisivanju podataka

Pre nego Sto prekinemo pricu o unosenju podataka, duznost mi je da
obradim nekoliko precica koje zaista pomazu da se smanji monotonija pri-
likom obavljanja ovog posla. Saveti za unoSenje podataka podrazumevaju
upotrebu opcija AutoComplete i AutoFill, unoSenje podataka u unapred
izabrane blokove €elija, kao i unosenje istovetnih podataka u €itavu grupu
Celija jednim potezom.

Slusanje glasa gospodara

Naredba za prepoznavanje govora (engl. speech recognition) spada medu
najzanimljivije funkcije Excela 2003. Pomocu nje, svoje zahteve Excelu
moZete da zadajete glasom. Kada koristite komandu za prepoznavanje
govora u rezimu diktiranja, Excel unosi u €elije radnog lista tekst ili vred-
nosti koje izgovarate. U reZimu zadavanja komandi, Excel bira menije s
komandama, palete alatki i opcije iz okvira za dijalog, onako kako vi to
zahtevate.

Jedina zvrcka sa ovom komandom jeste Sto racunar mora da ima dovoljno
brz procesor i odgovarajucu zvucnu karticu, a uz to treba da instalirate
ne samo opciju za prepoznavanje govora vec i da ,naucite” racunar da
prepoznaje vas glas (naravno, na engleskom jeziku). Kada se radi o
komponentama rac¢unara koje mogu da podrZe rad opcije za prepozna-
vanje govora, Microsoft preporucuje minimum Pentium II, brzine 300
MHz i najmanje 128 MB RAM memorije. Ako imate racunar koji ve¢ spada
u ,antikvitete“, zabavu u kojoj ,razgovarate® sa Excelom moracete da
zaboravite i da se latite stare dobre tastature.

Ako je vas raCunar dorastao ovakvom izazovu, ostaje da nabavite kva-
litetan mikrofon, najbolje onaj koji je u kompletu sa slusalicama (kakve
koriste piloti). Ovakav mikrofon, €ija se cena krece izmedu 40 i 80 ame-
rickih dolara, moZe se naci i u naSim prodavnicama elektronske i racu-
narske opreme. Jeftiniji mikrofoni nisu dovoljno osetljivi za ovakav vid
rada i, za razliku od mikrofona koji je u kompletu sa slusalicama, ne stoji
dovoljno blizu ustima, pa zato u mikrofon stizu i mnogi zvuci (Sumovi

i slicno) koji ometaju zadavanje komande glasom.
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Zvuci koji ometaju zadavanje komande mogu da predstavljaju veliki
problem prilikom koris¢enja komande Speech Recognition. Ako radite
u kancelariji u kojoj ima mnogo ljudi, gde vas stalno ometaju glasovi

i razgovori kolega, velike su Sanse da ¢e program za prepoznavanje
govora u Officeu 11, osim vaSeg glasa, pokupiti i gomilu raznih smetnji,
bez obzira na kvalitet mikrofona. Mozda mislite da su problemi koje
stvara komanda za prepoznavanje govora daleko veci od pogodnosti
koje pruZa - ¢askanje kolega za susednim stolovima Excel moze da
pretvori u gomilu neobi¢nih znakova u vasim radnim listovima, cak

i onda kada sami niSta ne diktirate u njih!

Opcija za prepoznavanje govora ne instalira se tokom standardne insta-
lacije paketa Office 11, mada je definisano da bude instalirana onda kada
prvi put pokrenete neki od programa iz ovog paketa. Speech Recogni-
tion, dakle, moZete instalirati iz Excela 2003: s linije menija izaberite
Tools = Speech = Speech Recognition. Program pokrece proces insta-
liranja opcije za prepoznavanje govora (§to, uzgred, zahteva koris¢enje
instalacionog diska Officea 11).

Posto ste uspesno instalirali opciju za prepoznavanje govora, na sredini
prozora Excelove radne sveske pojavljuje se paleta jezika pomocu koje
mozete da menjate i doterujete zadate parametre govora. (Ako se ne
pojavi, na liniji menija izaberite Tools => Speech = Speech Recognition.)
Za razliku od ostalih Excelovih plutajucih paleta alatki koje moZete usi-
driti uz jednu stranu prozora (u poglavlju 3 potraZite vise pojedinosti o
sidrenju paleta), paleta Language stalno pluta i tako zaklanja deo Excelo-
vog ekrana.

Ovaj problem moZzete resiti jedino ako minimizirate paletu Language, pa
Ce se njene alatke naci na paleti poslova Windowsa XP levo uz oblast za
obavestenja — poslednja oblast zdesna u kojoj je prikazano tekuce vreme
(slike 2-9 i 2-10 prikazuju minimiziranu paletu jezika na Windowsovoj
paleti poslova). Tako necete morati da premestate paletu Language dok
radite, §to bi moglo da dovede i do greSaka u prepoznavanju govora
ukoliko pokusSate da je premestite usred diktiranja ili zadavanja komandi
glasom.

Paletu Language minimiziracete ako pritisnete dugme sa znakom minus
iznad strelice nadole na samom kraju plutajuce palete. Kada prvi put
pritisnete ovo dugme, Excel prikazuje okvir za dijalog sa upozorenjem
da, ukoliko je minimizirana, paleta Language moZe ponovo da se poveca
ako se iz njenog priruc¢nog menija izabere stavka Show the Language Bar.
Ne obracajte paznju na ovo upozorenje (Cak moZete potvrditi polje Don’t
show me this message again kako se upozorenje ne bi ponovo pojavlji-
valo) i pritisnite OK da biste zatvorili okvir sa upozorenjem i postavili
ikonice palete Language na paletu poslova Windowsa XP (slika 2-9).
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]
Slika 2-9:
Potpuna paleta
Language
minimizirana na
paleti poslova
Windowsa XP.

Potpuna paleta Language
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Zadavanje naredaba glasom

Paleta Language se pojavljuje u dva oblika: celovitom i saZetom. U celo-
vitom obliku prikazana je sva dugmad (Microphone, Dictation, Voice
Command, Current Mode, Speech Tools, Handwriting i On-Screen Key-
board), kao §to se vidi na slici 2-9. SaZeta verzija palete sadrzi svu dug-
mad izuzev Dictation, Voice Command i Current Mode (slika 2-10).

Ako Zelite da se paleta Language pojavi u saZzetom obliku, pritisnite
dugme sa slic¢icom mikrofona. Paleta ce se skratiti jer ¢e dugmad Dicta-
tion, Voice Command i Current Mode biti skrivena, a bice iskljuCena

i opcija za prepoznavanje govora (ona radi samo s potpune palete
Language).

Paleta Language se prosiruje i prikazuje u potpunoj verziji kada priti-
snete dugme Microphone. Tako, ne samo da ¢e biti prikazana dugmad
s palete Language, vec ce se ukljuciti i opcija za prepoznavanje govora
u rezimu diktiranja, Sto pokazuje i reC Listening na dugmetu tekuceg
rezima (ono s nacrtanim oblaci¢em za tekst). Kada pritisnete trece
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Slika 2-10:
SaZeta

verzija palete
Language
minimizirana na
paleti poslova
Windowsa XP.

dugme sleva, Voice Command, prelazite iz reZima diktiranja u reZim gla-
sovnog zadavanja komandi (Cime se na dugmetu tekuceg reZima ispisuje
Voice Command).

Obudite Excel da prepoznaje glas

Pre nego Sto pokusSate da upotrebite opciju za prepoznavanje glasa —
urlajuc¢i komande i podatke koje treba uneti u radni list — treba da naucite
Excel da prepoznaje vas govor. Postupak obuke je jednostavan, mada
ponekad oduzima puno vremena i ume da bude zamoran. Da biste
zapoceli ovu obuku, sledite naredne korake:

1. Izaberite Tools > Speech > Speech Recognition da biste prikazali
paletu Language.

2. Na paleti Language pritisnite dugme Speech Tools, a zatim u
pomocé¢nom meniju izaberite stavku Training (slika 2-10).

Prvi okvir za dijalog carobnjaka Voice Training otvara se u lekciji
koju izaberete. Carobnjak nudi nekoliko razli¢itih lekcija; Sto ih vise
prodete, to ¢e racunar bolje prepoznavati govor.

SaZeta paleta Language
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3. U uvodnom okviru za obuku (Introduction to Microsoft Speech
Recognition) Carobnjaka Voice Training, pritisnite dugme Next.

Drugi okvir za dijalog ¢arobnjaka Voice Training trazi da naznacite
kog ste pola i starosti (mladi od 12 godina, ili 13 godina i stariji).

4. Izaberite radio-dugme Male (musko) ili Female (Zensko), a zatim
dugme 13 yrs and Up (13 godina i vise) ili 12 yrs or Less (12
godina ili manje) i potom pritisnite dugme Next.

5. U sledecem okviru za dijalog pritisnite dugme Sample da biste
proverili poloZaj svog mikrofona, a zatim pritisnite Next.
Dok izgovarate tekst za obuku, mikrofon mora da stoji neposredno
ispred vasih usana i kada obuka pocne, ne bi trebalo vise da ga
pomerate.

6. Naglas procitajte tekst ,, This papaya tastes perfect” i poslusajte
njegovu reprodukciju. Ako je neophodno, podesite razdaljinu
izmedu usana i mikrofona, sve dok u reprodukovanom zapisu ne
dobijete zadovoljavajuci zvuk izgovorenog teksta. Kada je polozaj
mikrofona podesen, pritisnite dugme Finish da biste zapoceli
uvodnu obuku za prepoznavanje glasa.

Tokom obuke za prepoznavanje glasa, Citacete tekst koji ¢e se poja-
vljivati u zasebnom polju okvira za dijalog Voice Training. Dok
budete Citali tekst, opcija za prepoznavanje glasa Speech Recog-
nition istaci ce reci koje prepozna.

Procitajte tekst normalnim glasom, ne pravite pauze i ne naglasa-
vajte reci ponaosob. Najbolje da reci Citate kao recCenice.

7. Citajte tekst dok se pojavljuje u odgovarajucem polju sledeceg
okvira za dijalog Carobnjaka Voice Training.
Ako ustanovite da Carobnjak za obuku nije u stanju da razume
odredenu re¢, pritisnite dugme Skip Word kako biste presli na sle-
decu rec (preskakanje nekoliko reci nece nepovoljno uticati na tok
obuke). Kada stigne do nerazumljivih reci, Carobnjak za obuku ¢e
zastati; nece hteti da nastavi dalje i istakne reci koje je prepoznao.
Ako morate da napravite pauzu ili vas je neko prekinuo, pritisnite
dugme za pauzu. Lekciju obuke nastavicete pritiskom na dugme
Resume.
Kada zavrsite sa izgovaranjem teksta, Carobnjak ce otvoriti okvir za
dijalog u kome ce azurirati vas profil (napravljen u trenutku insta-
liranja softvera za prepoznavanje govora), gde ce prikazati rezultate
obuke. Kada se zavrsi azuriranje, pojavice se poslednji okvir za dija-
log carobnjaka Voice Training. U ovom okviru mozete izabrati da li
Zelite da nastavite obuku za prepoznavanje govora ili da zatvorite
program Carobnjaka i vratite se u Excel kako biste tamo poceli da
koristite softver. Excelu moZete da diktirate naredbe ili podatke koje
treba upisati u Celije.
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8. Pritisnite dugme za dodatnu obuku prepoznavanja glasa — More
Training (Sto viSe obuke, to je prepoznavanje preciznije).
ili
Ako Zelite da isprobate softver za prepoznavanje govora pre nego
Sto nastavite obuku, pritisnite dugme Finish.

Kada pritisnete dugme Finish, Carobnjak za obuku se zatvara i vrac¢a vas
u Excel 2003. Sada u Excelu moZete isprobati program za prepoznavanje
govora.

Naterajte Excel da belezi diktat!

Podatke u radni list moZete unositi pomocu softvera za prepoznavanje
govora, u rezimu diktata. Da biste to uradili, treba da aktivirate softver
za prepoznavanje govora u Excelu, a zatim obavezno proverite da li je
na paleti Language izabran reZim diktiranja, pre nego Sto zapocCnete
diktiranje.

1. Pokrenite Excel.

2. Stavite na glavu komplet slusalica i mikrofona. Pre nego sto posta-
vite pokazivac u ¢eliju radnog lista u kojoj Zelite da pocnete sa
unosom podataka, postavite mikrofon na odgovarajucéu udaljenost
od usana.

3. U Excelovom meniju izaberite Tools > Speech > Speech Recogni-
tion, kako biste otvorili paletu Language.
Paletu Language postavicete na paletu poslova Windowsa XP kada
pritisnete dugme za minimiziranje (sa znakom minus) na desnom
kraju palete Language.

4. Proverite da li se re€ Dictation ili Listening pojavljuje na dugmetu
tekuceg reZima (ono s nacrtanim oblacicem za tekst; videti sliku
2-9). Ako je paleta Language saZeta (kao Sto je prikazano na slici
2-10), pritisnite dugme Microphone da biste je prosirili i prikazali
dugmad Dictation (diktiranje) i Voice Command (zadavanje
komandi glasom).

5. Pritisnite dugme Dictation na paleti Language da biste izabrali
rezim diktiranja.

6. Pocnite da diktirate podatke (tekst ili vrednosti) koje Zelite da
unesete u tekucu celiju.
Prilikom diktiranja podataka, izgovarajte ceo broj, zaglavlje ili izraz
koji Zelite da unesete u celiju (u tabeli 2-3 prikazani su nazivi odre-
denih znakova interpunkcije i simbola). Dok izgovarate ono §to
treba da bude uneto u celiju, ne brinite ako se vrednosti ili reci ne
pojave istog trenutka u celiji i u polju za formule - racunar ne prika-
zuje tekst sve dok ne zavrSi obradu zvu¢nog unosa. Posmatrajte
dugme sa oblaci¢em, s desne strane dugmeta Voice Command na
paleti Language. U oblacicu ce se pojaviti saveti kako treba da prila-
godite svoj govor, ako racunar ne uspeva da prepozna neke reci.
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Ukoliko ne prepozna podatke koje ste hteli da unesete i u ¢elijama se
pojavi nerazumljiv tekst, pritisnite taster Esc i ponovo izgovorite
vrednost ili tekst.

7. ReZim diktiranja iskljucCicete kada pritisnete dugme Microphone
na paleti Language ili u meniju izaberete Tools~> Speech > Speech
Recognition (svejedno je da li pritisnete dugme Microphone ili ovu
naredbu izaberete iz Excelovog menija).

U tabeli 2-3, navedene su pojedinacne reci, ili — u nekim slucajevima —
nekoliko reci koje treba da izgovorite za uobiCajene znakove inter-
punkcije i simbole koji vam mogu zatrebati tokom diktata. (Speech Recog-
nition ne moze da interpretira komande zadate na srpskom jeziku, pa je
stoga neophodno da naucite kako se pravilno izgovaraju engleske reci
navedene u tabeli 2-3, prim. prev.)

Tabela 2-3 Reci koje se koriste za diktiranje uobicajenih znakova

interpunkcije i simbola
Rec(i) koje izgovarate Ono sto unosi program
za prepoznavanje govora

Ampersand &

Asterisk *

At @

At sign @

Bracket, Left bracket ili Open bracket [

Backslash \

Caret A

Close bracket, Right bracket ili End bracket 1

Close parenthesis ili Right paren )

Close quote

Close single quote

Colon

Comma .

Curly brace, Left brace ili Open brace {

Dollar sign $
Dot

Double dash --
Ellipsis
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Poglavlje 2: Izrada radnog lista od samog pocetka

Tabela 2-3 Reci koje se koriste za diktiranje uobicajenih znakova

interpunkcije i simbola (nastavak)

Rec(i) koje izgovarate

Ono sto unosi program
za prepoznavanje govora

End curly brace, Right brace ili Close brace

Equals

Exclamation point

Greater than

Hyphenili Dash

Less than

Open brace

Open bracket

Open quote ili Quote

Open single quote ili Single quote

Paren

Percentili Percent sign

%

Period

Plus ili Plus sign

Pound sign

Question mark

Quote ili Open quote

Right bracket

Semi-colon

Slash

Tilde

Underscore

Vertical bar

Prilikom diktiranja brojeva u ¢elije, imajte na umu sledece:

v Izgovorene brojeve iz intervala od 0 do 20 Speech Recognition uba-
cuje u Celije kao tekst (ako izgovorite broj Cetiri — ,,four”, u polju ce

pisati four).

v Izgovoreni brojevi pocev od 21 i veci upisuju se u Celije kao arapski
brojevi (ako kazete 22, tj. ,twenty-two“ u €eliju €e biti upisan broj22).
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c,?N“

Ako diktirate vrednost kao sto je $4524,56, dovoljno je da na engleskom
izgovorite razgovetno: ,four thousand five hundred twenty-four dollars
fifty-six cents.“ Izbegavajte da posle izgovorene reci dollars dodajete
and, jer ¢e to samo zbuniti Speech Recognition.

Naterajte Excel da ispunjava svaku vasu naredbu!

Koliko god vam se dopala opcija diktiranja u programu Speech Recogni-
tion, meni se €ini da je glasovno zadavanje komandi (Voice Command)
najbolji deo ovog programa. MoZda je to zato Sto mi ne smeta da vred-
nosti i tekst unosim u Excelov radni list preko tastature. Ali zato viSe
volim da ne koristim miSa prilikom zadavanja komandi Excelu. Kada je
u pitanju naredivanje, viSe volim da koristim svoja usta nego miSa.

Da biste naterali Excel da ispunjava glasovne komande, predite iz rezima
diktiranja u komandni reZim. Da biste to uradili, na paleti Language
pritisnite dugme Voice Command. Ako se paleta ne vidi na ekranu, u
komandni reZim preci cete na sledeci nacin:

1. Na Exlcelovoj liniji menija izaberite Tools => Speech => Speech
Recognition. Otvorice se paleta Language.

2. Na paleti Language pritisnite dugme Voice Command da biste
presli u reZim glasovnog zadavanja komandi (tom prilikom se
na dugmetu tekucéeg reZima, onog sa oblaci¢em, pojavljuje tekst
Voice Command). Ako je paleta Language prikazana u saZetoj verziji,
pa je ovo dugme skriveno, pritisnite dugme Microphone da biste
prosirili paletu na punu velic¢inu. Tada ¢ée se pojaviti i dugme
Voice Command.

3. Pocnite da diktirate komande iz Excelovog menija i palete alatki
ili komande za pomeranje pokazivaca celija.

4. Kada zavrsite sa izgovaranjem komande (pod pretpostavkom da
je Excel uradio sve Sto ste Zeleli), na paleti Language pritisnite
dugme Microphone kako biste iskljucili mikrofon.

Prilikom diktiranja komandi Excelu, vodite racuna o nekoliko stvari.

(U narednim primerima, ono Sto treba da izgovorite napisano je izmedu
navodnika. Ne zaboravite da su ovo samo primeri, a ne nesto Sto radite
svaki put.)

v Da biste izabrali komandu iz Excelovog menija, izgovorite ime
menija (,,Format®), a zatim ime stavke menija (,,Column®). Ako
izabrana komanda ima podmeni, izgovorite ime stavke s podmenija
(,,AutoFit Selection®). Da biste izasli iz ovih menija, recite ,,Cancel”
ili ,Escape” sve dok se ne zatvore svi meniji.
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Poglavlje 2: Izrada radnog lista od samog pocetka

NET

v Zaizbor alatke s bilo koje prikazane palete (od kojih su standardno
prikazane samo palete Standard i Formatting), izgovorite ime alatke
(,Bold", ,Align Right*, ,Print Preview* ili ,Save®). U tabelama 1-2 i
1-3 potrazite nazive svih alatki na paletama Standard i Formatting.
Ako Zelite da pomocu glasovne komande prikaZete i ostale palete
alatki, izgovorite ,View", pa onda , Toolbars“, a potom ime palete
koju hocete da otvorite.

v U okviru za dijalog koji ste otvorili glasovnim izborom menija ili
palete alatki, opcije moZete birati tako Sto izgovorite ime kartice
koju Zelite da vidite (,,General®), a potom ime opcije koju hocete da
izaberete ili promenite (,,Sheets in Workbook*). Ako opcija podra-
zumeva nekakav unos, uradite to pomocu tastature ili misa. Kada
izmenite opcije u okviru za dijalog, recite ,OK“. Okvir ce se zatvo-
riti, a zadate izmene ce biti saCuvane. Kazite ,,Cancel“ da biste
zatvorili okvir poniStavajuci sve izmene.

v Pokazivac celija pomericete ako izgovorite naziv odgovarajuceg
tastera (pogledajte tabelu 1-4). Da biste ga pomerili na nacin koji
odgovara upotrebi tastera sa strelicama, treba da izgovorite
LArrow“, a zatim rec€ koja odreduje pravac strelice (,,Left“, ,Right“,
L,Up“ili ,Down®). ,Arrow Left“ znaci da pokazivac treba da se
pomeri u prvu sledecu kolonu sleva; ,Arrow Up“ pomera pokazivac
u prvi slededi red iznad tekuceg.

Umesto ,Arrow Right“ moZete reci i , Tab“, a ,,Shift Tab“ umesto
L~Arrow Left“. Tako se pokazivac¢ premesSta u prvu sledecu celiju
levo, odnosno desno.

Pokazivac celije moZete premestiti u kolonu A tekuceg reda ako
kazete ,Home*“. Da biste pomerali prikaz radnog ekrana vertikalno
i horizontalno, recite ,Page Up*“ ili ,Page Down*. Imajte u vidu da
Speech Recognition ne prepoznaje kombinacije tastera u kojima se
koristi taster Ctrl. Zato, ako Zelite da pomerate pokazivac celija u
intervalima veéim od jednog ekrana (vidi tabelu 1-4), izgovorite
»,End“, a zatim ime odgovarajuce strelice. Na primer, ako kazete
»,End, Right Arrow“, Excel ¢e pomeriti pokazivac celija na prvu
zauzetu Celiju u tekucem redu koja se nalazi ispred ili iza prazne
Celije. Ukoliko su sve Celije s desne strane prazne, pokazivac celije
premestice se na kraj reda, u poslednju kolonu, to jest u kolonu IV.

Zatvaranje palete Language

Kada viSe necete da unosite podatke u celije diktiranjem i zadajete Exce-
love komande glasom, moZete zatvoriti paletu Language. Desnim tas-
terom miSa pritisnite bilo gde na paleti i potom iz priru¢nog menija
izaberite opciju Close the Language Bar. Pojavice se okvir za dijalog

sa upozorenjem da ste zatvorili paletu. Pritisnite dugme OK i paleta ce
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84 Deo I: Ulazak na osnovni nivo

se ukloniti s vidika. (Isto tako, moZete potvrditi polje Do not show me
this message again, kako se ovo upozorenje ne bi nadalje pojavljivalo
pri zatvaranju palete Language).

Sledeci put kada vam zatreba paleta Language radi diktiranja teksta ili
komandi u Excelu, ponovo cete je otvoriti ako izaberete opciju Tools =
Speech => Speech Recognition.

Analiziranje rukopisa

Glas nije jedini nov nacin unoSenja zapisa u Celije radnog lista. Excel 2003
podrzava i novu opciju prepoznavanja rukopisa (engl. handwriting recog-
nition) koja moze da pretvori tekst i vrednosti pisane rukom u elektron-
ski zapis. Imajte u vidu da, iako opcija prepoznavanja rukopisa podrzava
upotrebu posebnog ulaznog uredaja — na primer graficku tablu koju
moZete povezati s raCunarom - ipak postoji moguc¢nost da u celije upisu-
jete sadrzaj pomoc¢u miSa (Sto je prakti¢no koliko i pisanje komadom
sapuna).

Opcija prepoznavanja rukopisa dostupna je iz palete Language (mada se
instalira zasebno) koju otvarate u Excelu kada na liniji menija izaberete
Tools = Speech = Speech Recognition. Kada pritisnete dugme Handwrit-
ing na paleti Language (slika 2-10), pojavljuje se pomoc¢ni meni sa
sledecim opcijama:

v Pritisnite stavku Writing Pad da biste otvorili istoimeni okvir za
dijalog gde ru¢no mozZete uneti zapis u €eliju.

v Pritisnite stavku Write Anywhere kako biste otvorili istoimenu
paletu. Kada je ova paleta otvorena, za pisanje moZete koristiti
ceo ekran.

v Pritisnite stavku On-Screen Standard Keyboard i otvoric¢e se mini-
jaturna standardna tastatura, po kojoj moZete da kucate (ako kori-
stite graficku tablu) ili pritiskate miSem, kao dopunu ruénom
pisanju ili umesto njega.

v Pritisnite stavku On-Screen Symbol Keyboard da biste otvorili
mini-tastaturu na kojoj su prikazani tasteri za unos slova koja se
najcesce koriste u evropskim jezicima (francuskom, Spanskom i
nemackom). Kao i na standardnoj (engleskoj) tastaturi, akcentirana
slova i specijalne znake sa ove tastature moZzete unositi kucanjem
po ovoj tastaturi (ako koristite graficku tablu) ili pritiskanjem
tastera misa.

Zapis unet ru¢no pomocu opcija Writing Pad ili Write Anywhere bice
automatski prepoznat i umetnut u tekucu ¢eliju pod bilo kojim od
sledecih uslova:
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v Napisali ste dovoljno teksta koji opcija Handwriting moZe da
prepozna.

v Napravili ste izvesnu pauzu u pisanju.
v Stigli ste do kraja reda u okviru za dijalog Writing Pad.

v Pritisli ste dugme Recognize Now (oznaceno slovom T koje se
dodaje strani).

Ako opcija za prepoznavanje rukopisa nepravilno interpretira vas ruko-
pis — pa zato u Celiju unese pogresan zapis — pristisnite taster Backspace
kojim cete obrisati sve pogreSne znake, a zatim pokuSajte da ih ponovo
unesete.

Okvir za dijalog Writing Pad i paleta Write Anywhere sadrze dugmad za
uredivanje koju moZete da pritiskate olovkom graficke table ili miSem
(umesto da ih pritiskate sa obiCne tastature):

v Enter ZavrSava unos i premesta pokazivac celije jedan red nanize.
v Backspace BriSe znake s leve strane kursora.
v Space Unosijedno prazno mesto (razmak) u zapis.

v Tab ZavrSava unos i premesta pokazivac celije u sledecu kolonu
zdesna.

v Clear: Brise znake s desne strane kursora.

Pored ovoga, okvir za dijalog i paletu alatki moZete prosiriti tako da se na
njima pojavi jos alatki. Kada pritisnete dugme >> prosirice se ili okvir ili
paleta i na njima ce biti prikazane dodatne alatke. Medu dodatnim alat-
kama je i tastatura sa Cetiri strelice, koje pokazuju Cetiri razlicita pravca
i dugmadima koje mozZete koristiti za zavrSetak unosa u celiju i prelazak
u sledecu celiju u pravcu strelice.

Bez tebe sam nekako nepotpun

Opcija AutoComplete u Excelu 2003 nije svemoguca: toga morate biti
svesni dok unosite podatke. U pokuSaju da vam barem malo olakSaju
dosadan posao unosenja podataka, dobroc¢udni projektanti softvera

u Microsoftu smislili su opciju AutoComplete.

AutoComplete je nesto kao priglupi ¢ita¢ misli koji na osnovu onoga sto
ste upisali ranije predvida Sta je sledece Sta biste mogli upisati. Ova opcija
dolazi do izraZaja samo kada unosite kolonu tekstualnih stavki. (Neradi
prilikom upisivanja vrednosti i formula, kao ni pri popunjavanju redova
Celija tekstom.) Kada kolonu celija popunjavate tekstom, AutoComplete
pamti upise u celije i automatski ih duplira u slede¢im redovima kad god
novi upis pocnete istim slovom kojim pocinje postojeci upis u koloni.
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]
Slika 2-11:
AutoComplete
duplira
prethodni

upis ukoliko

u istoj koloni
zapoCnete

novi upis istim
slovom kojim
poéinje
postojeci upis.
]

S

Primera radi, recimo da sam upisao Dijetni centri Spartanac (jedna od
kompanija pod upravom preduzeca Labava poslovna grupacija) u celiju
A3, da sam zatim pomerio pokazivac celije jedan red nize u celiju A4 i
pritisnuo D (veliko ili malo, svejedno), AutoComplete u tu ¢eliju automat-
ski ubacuje , ijetni centri Spartanac“iza slova D, kao §to je prikazano

na slici 2-11.
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To je veoma zgodno ako mi Dijetni centri Spartanac treba kao zaglavlje
redaiu Celiji A3 i u Celiji A4. Medutim, predvidajuci da ¢u mozda hteti da
upiSem nesto drugo, §to takode pocinje slovom D, AutoComplete osta-
vlja istaknut ceo tekst iza prvog slova (u ovom slucaju od , ijetni“). To
znaci da ¢u, ako nastavim da kucam, zameniti umetnuti tekst novim tek-
stom (Sto bih i uradio nakon snimanja slike 2-11, da mi je trebalo da
upiSem Detektivsku agenciju Malog Bore — joS jednu od kompanija u vla-
snistvu Labave poslovne grupacije — u celiju A4).

Ako upisivanjem novog teksta prepiSete umetnuti tekst koji je AutoCom-
plete ubacio u kolonu (kao Sto bih ja uradio, upisujuci Detektivsku agen-
ciju umesto Dijetnih centara u Celiju A4), definitivno ukidate njegovu
sposobnost da i dalje upisuje duplikate za to konkretno slovo. U mom
primeru, nakon S§to sam tekst Dijetni centri Spartanac zamenio tekstom
Detektivska agencija u celiji A4, AutoComplete nece uciniti nista ako u
Celiju A5 upiSem slovo D. Drugim reCima, bi¢ete prepusteni sami sebi ako
ne prihvatite njegove preporuke za upisivanje teksta.

Ukoliko vam opcija AutoComplete zadaje muke prilikom unosa niza
podataka u celije koji pocinju istim slovom, ali se inacCe razlikuju, mozete
je iskljuciti. Izaberite Tools => Options i potom karticu Edit. Zatim, pre
nego Sto pritisnete OK, uklonite znak za potvrdu pored opcije Enable
AutoComplete for Cell Values.
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Popunjavanje opcijom AutoFill

Mnogi radni listovi koje pravite u Excelu zahtevaju da unesete niz uza-
stopnih datuma ili brojeva. Na primer, naslovicete kolone nazivima kalen-
darskih meseci, od januara do decembra, ili ¢ete numerisati redove,
recimo od 1 do 100.

Excelova opcija AutoFill ovaj posao obavlja u jednom potezu. Treba samo
da unesete pocetnu vrednost niza. U vecini slu¢ajeva, opcija AutoFill je
dovoljno pametna da pretpostavi kako treba razviti niz dok vi povlacite
rucicu za popunu nadesno (za postavljanje niza vrednosti u kolone) ili
naniZe (za postavljanje niza vrednosti u redove).

NET
< Ne zaboravite da rucica za popunu pomocu opcije AutoFill izgleda kao

mali znak plus (+) i da se pojavljuje samo kada pokaziva¢ misa postavite
nad donji desni ugao celije (odnosno poslednje celije, ukoliko ste izabrali
blok celija). Kad povlacite blok ¢elija pokazivacem u obliku belog krsta
a ne rucicom za popunu, Excel samo proSiruje blok na nove celije (vise
o tome procitajte u poglavlju 3). Ako povlacite blok celija pokazivacem
u obliku strelice, Excel premesta blok (poglavlje 4).

Prilikom ispisivanja niza pomocu rucice za popunu, moZzZete povlaciti
samo u jednom pravcu. Na primer, moZete ispisati niz ili popuniti pod-
rucje ulevo ili udesno od podrucja ¢elija koje sadrZe pocetne vrednosti.
Takode mozZete ispisati niz ili popuniti podrucje celija iznad ili ispod
podrucja €elija koje sadrZe pocetne vrednosti. Medutim, ne mozZete ispi-
sati niz ili popuniti podrucje u oba pravca istovremeno (recimo nanize i
udesno dijagonalnim povlacenjem rucice za popunu).

Dok povlacite miSa, program vas obaveStava o sadrzaju koji ¢e biti
smeSten u krajnju celiju izabranog podrucja, tako sto ga ispisuje pored
pokazivaca miSa (neka vrsta vodica za AutoFill). Kada nakon produza-
vanja niza ru¢icom za popunu otpustite taster misa, Excel ce sve iza-
brane celije popuniti vrednostima niza ili po€etnom vrednoscu. Desno
od poslednjeg unosa u popunjenom ili kopiranom podrucju celija, Excel
prikazuje i dugme koje otvara meni sa opcijama. Pomocu ovog menija
moZete iskljuciti opciju standardnog popunjavanja ili kopiranja. Na pri-
mer, kada koristite ru¢icu za popunu, Excel kopira poCetnu vrednost u
izabrano podrucje celija. Ali, ukoliko Zelite da upiSete niz podataka, to
mozZete uciniti pomocu komande Fill Series koja se nalazi u priruénom
meniju AutoFill Options.

Slike 2-12 i 2-13 ilustruju upotrebu opcije AutoFill za upisivanje naziva
kalendarskih meseci, poCev od januara u celiji B2 do juna u celiji G2. Da
biste to uradili, jednostavno upiSite januar u celiju B2 i postavite poka-
ziva€ miSa na rucicu za popunu u donjem desnom uglu Celije a zatim je
povucite udesno do celije G2 (slika 2-12). Kada otpustite taster miSa,
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Slika 2-12:
UpiSite januar
u prvu celiju,
a zatim
povlaéenjem
rucice za
popunu
izaberite
podrucje celija
koje cete
popuniti
nazivima
kalendarskih
meseci.

Slika 2-13:
Kad otpustite
taster misa,
Excel
popunjava
izabrani blok
¢elija nazivima
kalendarskih
meseci koji
nedostaju.

Excel ¢e upisati nazive preostalih meseci (od februara do juna) u
izabrane Celije (slika 2-13). Primeticete da Excel ostavlja ove celije istak-
nute, pruzajudi vam priliku da - ako ste povukli previSe — vratite rucicu
za popunu ulevo i uklonite nazive meseci koji vam ne trebaju. Ako niste
dovoljno povukli, moZete ponovo uhvatiti ru¢icu za popunu i povuéi je
udesno da biste produzili niz meseci za onoliko koliko je potrebno.
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MozZete koristiti i opcije sa priru¢nog menija AutoFill (otvara se pritiskom
na dugme koje se pojavljuje na ruc€ici za popunu, desno od juna) kako
biste izbegli automatsko popunjavanje celija. Ako Zelite da Excel kopira
januar u svaku izabranu celiju, na ovom meniju izaberite opciju Copy
Cells. Da bi program popunio izabrane celije u formatu koji je korisS¢en

u Celiji B2 (detalje o formatiranju celija potraZite u poglavlju 3), u ovom
meniju izberite Fill Formatting Only. Kada iz menija izaberete stavku Fill
Without Formatting, Excel ¢e ispisati niz kalendarskih meseci u podrucju
izabranih celija, ne kopirajuci pri tom i format koriS¢en u celiji B2.
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Poglavlje 2: Izrada radnog lista od samog pocetka

U tabeli 2-4 u narednom odeljku prikazane su razne pocetne vrednosti
koje se mogu upotrebiti sa opcijom AutoFill, kao i vrste nizova koje ce
Excel napraviti na osnovu njih.

Tabela 2-4 Uzorci nizova koje moZete praviti opcijom AutoFill

Vrednost upisana Razvijen niz koji stvara AutoFill u tri sledece celije
u prvu celiju

Jun Jul, Avgust, Septembar

Jun Jul, Avg, Sep

Utorak Sreda, Cetvrtak, Petak

Uto Sre, Cet, Pet

1.4.99 24.99,3.4.99,4.4.99

Jan-00 Feb-00, Mar-00, Apr-00

15-Feb 16-Feb, 17-Feb, 18-Feb

10:00 PM 11:00 PM, 12:00 PM, 1:00 AM

8:01 9:01, 10:01, 11:01

Kvartal 1 Kvartal 2, Kvartal 3, Kvartal 4
Qtr2 Qtr3, Qtr4, Qtr1

a3 Q4, 1, Q2

Proizvod 1 Proizvod 2, Proizvod 3, Proizvod 4
1 Proizvod 2 Proizvod, 3 Proizvod, 4 Proizvod

Rad sa razmaknutim nizovima

Pocetna vrednost koju izaberete (datum, vreme, dan, godina itd.), Auto-
Fill koristi za ,dizajniranje* niza. Svi uzorci nizova u tabeli 2-4 uvecavaju
se za faktor 1 (jedan dan, jedan mesec, broj jedan). AutoFillu moZete da
naredite da stvara nizove s faktorom razli¢itim od 1: u dve susedne celije
upiSite vrednosti koje ¢e posluZiti kao uzorak i koje predstavljaju razliku
koju Zelite izmedu uzastopnih vrednosti u nizu. Neka ove dve vrednosti
budu pocetna selekcija koju ¢ete produziti rucicom za popunu.

Na primer, da biste poceli niz subotom i upisali svaki drugi dan duz jed-
nog reda, upisite Subota u prvu celiju i Ponedeljak u susednu celiju.
Posto izaberete ove dve celije, povucite rucicu za popunu udesno preko
celija, onoliko koliko vam treba. Kada otpustite taster misa, Excel ¢e, u
skladu s primerom postavljenim u prve dve celije, u ostale celije upisati
svaki drugi dan (sreda iza ponedeljka, petak iza srede itd.).
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Kopiranje pomocu AutoFilla

AutoFill moZete upotrebiti da biste iskopirali tekstualni upis u celo
podrucje €elija (umesto da popunjavate nizove srodnih upisa). Da biste
kopirali tekstualni upis u podrucje celija, morate drzati pritisnut taster
Ctrl dok pritiskate ru€icu za popunu i povlacite je. Kad pritisnete miSem
ruCicu za popunu dok drzite pritisnut taster Ctrl, pojavljuje se znak plus
s desne strane rucice — znak da ce AutoFill kopirati sadrzaj tekuce celije
a ne na osnovu njega formirati niz (to se vidi i po tome Sto se pored poka-
zivaca miSa koji povlacite vidi stalno isti sadrZaj, jednak sadrZaju
pocetne celije). Ako Zelite da posle kopiranja inicijalnog teksta ili vred-
nosti taj sadrzaj iskoristite za popunjavanje niza celija, pritisnite dugme
za otvaranje padajuceg menija na rucici za popunu u poslednjoj ¢eliji u
koju je kopiran unos. Pojavice se priru¢ni meni opcije AutoFill gde treba
da izaberete stavku Fill Series.

Mada drzanje pritisnutog tastera Ctrl dok povlacite ruc€icu za popunu
kopira tekstualni upis, sasvim suprotno vaZzi kad su u pitanju numericke
vrednosti! Ako upiSete broj, recimo 17, u celiju i povucete rucicu za
popunu duZ reda, Excel ce kopirati broj 17 u sve izabrane celije. Medu-
tim, ako pri tom drZite pritisnut taster Ctrl, Excel ¢e upisati niz brojeva
(17, 18, 19 itd.). Ukoliko drZzite pritisnut taster Ctrli napravite niz brojeva,
a zeleli ste samo da iskopirate vrednost iz prve celije, stvar se moze
popraviti tako Sto ¢ete u priru€nom meniju opcije AutoFill izabrati
stavku Copy Cells.

Izvada namenskih lista za AutoFill

Osim promene inkrementa u nizu koji se pravi opcijom AutoFill, moZete
praviti i nizove po izboru. Na primer, pod okriljem preduzeca Labava
poslovna grupacija nalaze se sledece kompanije:

v Dijetni centri Spartanac

v Centri za rekreaciju Fit i Nes

v Mama Julina slatka peciva

v RDD sanatorijum

v Perine pite i bureci

v Radionice za brze popravke Tik-tak

v Detektivska agencija mali Bora Okac

Umesto da kucate ovaj spisak kompanija u €elije svakog novog radnog
lista (ili da ga kopirate sa nekog postojeceg), moZete napraviti niz ciji ¢e
¢lanovi biti upravo nabrojane kompanije po navedenom redu. Ovakav
niz proizvodi ceo spisak kompanija jednostavnim upisivanjem Dijetni
centri Spartanac u prvu celiju i povlacenjem rucice za popunu preko
praznih celija u kojima treba da se pojave ostale kompanije.
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Poglavlje 2: Izrada radnog lista od samog pocetka 9 ’

Da biste napravili ovakvu vrstu niza po sopstvenom izboru, uradite
sledece:
1. Izaberite Tools -> Options da biste otvorili okvir za dijalog Options
(slika 2-14).
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2. U okviru za dijalog Options izaberite karticu Custom lists. Poja-
vice se polja Custom lists i List entries.
Kada ovo uradite, u polju Custom lists automatski je izabrana opcija
NEW LIST.
Ako ste vec utrosili vreme i trud na upisivanje liste po izboru u
podrucje Celija, predite na korak 3; ako to jo$ niste uradili, predite
na korak 6.

3. Pritisnite miSem bilo gde unutar polja Import list from cells,
a zatim pritisnite dugme Minimize dialog box (ono sa sli¢icom
malog radnog lista u desnom kraju polja Import list from cells)
tako da moZete da vidite svoju listu i da izaberete podrudje celija
(pogledajte poglavlje 3 da biste saznali viSe detalja o tome).

4. Posto izaberete Celije, pritisnite dugme Maximize dialog box.

5. Zatim pritisnite dugme Import da biste iskopirali listu u polje List
entries.
Predite na korak 8.
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6. Pritisnite miSem unutar polja List entries, a zatim upiSite stavke
liste, jednu po jednu (u redosledu koji vam je potreban). Oba-
vezno pritisnite taster Enter svaki put kada zavrsite upis stavke.
Kada se sve stavke liste po izboru nadu u polju List entries,

i u redosledu koji vam odgovara, predite na korak 7.

7. Pritisnite dugme Add kako biste listu stavki dodali u polje Custom
lists.
Napravite sve potrebne liste prema opisanoj proceduri. Kada
zavrSite, predite na korak 8.

8. Pritisnite dugme OK ili taster Enter da biste zatvorili okvir za dija-
log Options i vratili se u tekudi radni list.

Posto ste napravili listu po izboru, od tog trenutka nadalje dovoljno je da
upiSete prvu stavku liste u neku celiju i upotrebite rucicu za popunu da
biste celu listu upisali u €elije ispod ili udesno.

Ako ne Zelite da upisujete ni prvu stavku liste, iskoristite opciju AutoCor-
rect — pogledajte odeljak ,,AutoCorrect radi za vas*“ u ovom poglavlju -
koja €e je ispisati umesto vas odmah posto upiSete svoj omiljeni akronim
(na primer, ,dcs“ za ,Dijetni centri Spartanac®).

Umetanje specijalnih simbola

Excel 2003 olak§ao je unos specijalnih simbola u celije, recimo onih koji
oznacavaju valute, kao i specijalnih znakova, poput zastitnog znaka
robne marke i simbola za autorska prava. Simbol ili specijalni znak
unecete tako Sto Cete s linije menija izabrati Insert => Symbol.

Otvorice se okvir za dijalog Symbol (slika 2-15). Kao §to slika prikazuje,
u ovom okviru za dijalog nalaze se dve kartice: Symbols i Special Charac-
ters. Matematicki simbol ili oznaku valute s kartice Symbols unecete
kada izaberete odgovarajuci simbol iz liste i potom pritisnete dugme
Insert (a moZete i samo dvaput pritisnuti simbol). Specijalne znake,
recimo slova iz pisma nekog stranog jezika ili slova sa akcentom, une-
Cete kada otvorite padajucu listu Subset, izaberete naziv skupa znakova
koji vam je potreban i pritisnete odgovarajuce znakove u polju ispod.
Mozete umetati i Cesto koriSéene oznake valuta ili matematicke simbole,
kao §to su oznaka za evro ili znak plus-minus, kada ih pritisnete u oblasti
Recently used symbols (nedavno kori§c¢eni simboli) pri dnu ove kartice
u okviru za dijalog Symbol.

Da biste umetnuli specijalne znake, recimo zastitni znak, oznaku pasusa
ili tri tacke, otvorite karticu Special Characters okvira za dijalog Symbol,
pronadite simbol u listi s kliznom trakom, izaberite ga i potom pritisnite
dugme Insert. (Specijalne znake mozZete umetnuti i kada dvaput priti-
snete odgovarajuci znak.)
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Kada umetnete specijalne simbole i znake, zatvorite okvir za dijalog Sym-
bol pritiskom na dugme Close u gornjem desnom uglu.

Upisivanje podataka u blokove Ccelija

Kad u nov radni list treba da postavite tabelu s podacima, moZete pojed-
nostaviti unoSenje podataka ako, pre nego §to unesete ijedan podatak,
izaberete sve prazne Celije od kojih Ce se tabela sastojati. Postavite poka-
zivaC u prvu Celiju buduce tabele a zatim izaberite ostale potrebne celije
u susednim, uzastopnim kolonama i redovima (biranje podrucja ¢elija
opisano je u poglavlju 3). Posto ste izabrali blok celija, moZete da upiSete
prvi podatak u tabelu.

Kada neki skup, odnosno blok ¢elija (poznat i kao podrucje — engl. range)
izaberete pre unosenja podataka u njega, Excel ogranicava upisivanje
podataka u to podrucje na sledeci nacin:

v Program automatski pomera pokazivac u sledecu celiju podrucja
kada pritisnete dugme Enter ili taster Enter radi postavljanja upisa
u Celiju.

v U podrucju Celija koje se sastoji od nekoliko kolona i redova, Excel
pomera pokazivac celije naniZe u prvi sledeci red tekuce kolone
nakon Sto podatak postavite u celiju. Kad pokazivac celije stigne
do celije u poslednjem redu, njegovo sledece pomeranje postavlja
ga u prvi red susedne kolone desno. Ako podrucje celija ima samo
jedan red, Excel pomera pokazivac¢ duZ reda, sleva nadesno.

v Kada i poslednji podatak postavite u poslednju celiju izabranog
podrucja, Excel premesta pokazivac u prvu €eliju kompletirane
tabele. Pritisnite jedanput miSem neku od €elija (unutar ili izvan
izabranog podrucja, svejedno) ili neki od tastera sa strelicama,
kako biste ponistili izbor podrucja.
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Pazite da umesto dugmeta Enter ili tastera Enter (prilikom postavljanja
podataka u €elije izabranog podrucja) ne pritisnete neki od tastera sa
strelicama. Pritisak tastera sa strelicom poniStava izbor podrucja celija
kada Excel pomeri pokazivac €elije. Da biste pomerali pokazivac celije
po podrudju, a da ne narusite stanje podrucja, koristite sledece metode:

v Tasterom Enter pomerajte pokazivac celije niz redove i preko kolona
u podrucju. Upotrebite Shift+Enter za kretanje u suprotnom smeru.

v Pritisnite taster Tab da biste presli u sledecu €eliju u susednoj
desnoj koloni, a zatim nanize duz svakog reda u podrucju. Upotre-
bite Shift+Tab za kretanje u suprotnom smeru.

v Pritisnite Ctrl+. (tacka) da biste se prebacili iz jednog ugla podrucja
u drugi.

Ekspresno unosenje podataka

Ustedecete dosta vremena i truda ako jedan isti upis (tekst, vrednost ili
formula) treba da se pojavi u velikom broju €elija na radnom listu; mozete
ga uneti u sve te Celije jednim potezom. Najpre izaberite podrucja celija u
koja ¢e biti uneseni podaci. (Excel omogucuje da izaberete vise od jednog
podrucja za ovakvu vrstu posla — u poglavlju 3 naci cete visSe detalja o
tome.) Zatim pripremite upis u polju za formule i pritisnite Ctrl+Enter
kako biste ga uneli u sva izabrana podrucja.

Klju¢ uspeha ovakve operacije jeste drzanje tastera Ctrl dok pritiskate
Enter tako da Excel umetne sadrzaj polja za formule u sve izabrane celije.
Ako zaboravite da drZite pritisnut taster Ctrl i pritisnete samo taster
Enter, Excel ¢e postaviti upis samo u prvu celiju izabranog podrucja.

Podatke moZete joS brze da upisujete u listu s formulama ako izaberete
opciju Extend list formats and formulas na kartici Edit u okviru za dijalog
Options (okvir se otvara izborom Tools => Options s linije menija). Kada
izaberete pomenutu opciju, Excel automatski formatira nove podatke koje
upisujete u poslednji red liste tako da odgovaraju slicnim podacima u
redovima iznad i snima formule iz prethodnih redova. Imajte na umu da
ova mogucnost da ,projurite kroz tabelu“ podrazumeva da ru¢no upiSete
formule i formatirate podatke u najmanje tri reda koja prethode novom
redu.

Kako da poboljsate rad formula

Ranije u ovom poglavlju pokazao sam vam kako da pravite formule koje
izvrSavaju jednostavne matematicke operacije: sabiranje, oduzimanje,
mnoZenje i deljenje. (Pogledajte odeljak ,,Evo kako se prave te famozne
formule!*) Umesto da ni iz ega pravite sloZenije formule pomocu zamr-
Senih kombinacija osnovnih operacija, mozda cete pronaci neku od
Excelovih funkcija koja ¢e obaviti posao umesto vas.
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Poglavlje 2: Izrada radnog lista od samog pocetka

Funkcija (engl. function) je unapred definisana formula koja izvrsava
odredeni tip izraCunavanja. Da biste upotrebili funkciju treba samo da
obezbedite vrednosti koje ta funkcija koristi za svoja proraCunavanja

(u recniku kojim se sluZe gurui radnih tabela, te vrednosti se nazivaju
argumenti funkcije, engl. function arguments). Kao i u jednostavnim for-
mulama, argumente vecine funkcija moZete unositi kao numericke vred-
nosti (recimo 22 ili -4,56) ili, $to je uobicajeno, kao reference celija (npr.
B10) ili reference podrucja celija (npr. C3:F3).

Funkcije, kao i formule koje sami pravite, moraju pocinjati znakom jedna-
kosti (=) tako da Excel zna da funkciju treba da unese kao formulu, a ne
kao tekst. Iza znaka jednakosti upiSite ime funkcije. (Svejedno je dali cete
koristiti velika ili mala slova ukoliko ne pogresite pri upisivanju.) Iza
imena funkcije upiSite argumente za koje proracun treba da se izvrsi.

Svi argumenti funkcija moraju biti stavljeni u zagrade.

Ako funkciju upisujete neposredno u €eliju, nemojte upisati razmak
izmedu imena funkcije, znaka jednakosti i argumenata zatvorenih u
zagrade. Neke funkcije koriste viSe od jedne vrednosti za izvrSavanje
zadatih proracuna. U tom sluCaju argumente razdvojte tackom i zare-
zom, a ne praznim mestom.

Prvo upiSite znak jednakosti, ime funkcije i levu zagradu ( () koja
oznacCava mesto na kom pocinju argumenti funkcije. Zatim, umesto da
upisujete reference Celija, izaberite bilo koju celiju ili podrucje celija koje
hocete da upotrebite kao prvi argument. Ako funkcija koristi viSe argu-
menata, izaberite celiju ili podrucje celija koje ¢ete upotrebiti kao drugi
argument odmah poSsto upiSete tacku i zarez (;) kojom se zavrSava
unosenje prvog argumenta.

Kada unesete poslednji argument, upiSite desnu zagradu da biste
oznacili kraj liste argumenata, a zatim pritisnite dugme Enter ili taster
Enter, ili odgovarajucdi taster sa strelicom da biste postavili funkciju u
Celiju i da bi Excel izraCunao traZenu vrednost.

Ubacivanje funkcije u formulu pomocu
dugmeta Insert Function

Mada funkciju moZete ubaciti upisivanjem u €eliju, treba da znate da u
Excelu postoji i dugme Insert Function koje se nalazi na traci za formule.
Pomocu njega moZete birati funkciju u Excelu. Kada pritisnete ovo dugme,
otvara se okvir za dijalog Insert Function (slika 2-16) u kome birate odgo-
varajuce funkcije. Kada izaberete funkciju, Excel otvara okvir za dijalog
Function Arguments, u kome moZete navesti argumente funkcije. Pravu
korist od ovog okvira za dijalog uvidecete kada se pozabavite nekom od
neuobicajenih ili sloZenijih funkcija (neke od njih znaju da budu zaista
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]
Slika 2-16:

U okviru za
dijalog Insert
Function
izaberite
odgovarajuéu
funkciju.
]

Cupave). Veliku pomo¢ pri popunjavanju polja za argumente moZete
dobiti u okviru za dijalog Function Arguments ako u njegovom donjem
levom uglu pritisnete miSem hipervezu Help on this function.

Da biste otvorili okvir za dijalog Insert Function, izaberite celiju u koju
treba da postavite funkciju, a zatim pritisnite dugme Insert Function
(oznaceno je sa fx) na traci za formule. Pojavice se okvir za dijalog Insert
Function, slican onom na slici 2-16.
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Okvir za dijalog Insert Function sadrZi tri polja: tekstualno polje Search
for a function (pronalaZenje funkcije), polje s padajucom listom Or select
a category (izbor kategorije) i polje s listom Select a function (izbor
funkcije). Kada otvorite okvir za dijalog Insert Function, Excel auto-
matski istakne kategoriju Most Recently Used (skoro koriS¢ene) u polju
Or select a category, a u polju Select a function prikaze funkcije koje
obicno koristite.

Ako se potrebna funkcija ne nalazi medu onima koje su skoro koriscene,
morate izabrati odgovarajucu kategoriju za svoju funkciju u polju Select
a category. U slu¢aju da ne znate kojoj kategoriji pripada traZena funk-
cija, moracete da je potrazite tako Sto cete opisno zadati njenu namenu
u polju Search for a function, a onda pritisnuti taster Enter ili dugme Go.
Na primer, ako Zelite da pronadete funkciju koja izracunava ukupne vred-
nosti (engl. total value), u polje Search for a function upiSite rec total i
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Poglavlje 2: Izrada radnog lista od samog pocetka

pritisnite dugme Go. Excel zatim u polju Select a function prikazuje listu
funkcija koje izracunavaju total. Te funkcije moZete pregledati jednu po
jednu. Kada izaberete funkciju, u okviru za dijalog Insert Function poja-
vljuju se argumenti koje trazi data funkcija; u dnu okvira pojavljuje se

opis rada funkcije.

Kada pronadete i izaberete funkciju, pritisnite dugme OK da biste umet-
nuli funkciju u aktivnu celiju i otvorili okvir za dijalog Function Arguments.
U ovom okviru za dijalog, osim traZenih argumenata funkcije, prikazani su
i opcioni. Pretpostavite, na primer, da ste u polju Select a function izabrali
funkciju Sum i pritisnite OK. Cim to uradite program ubacuje

SUM()

u aktivnu €eliju i u polje za formule (iza znaka jednakosti), a na ekranu se
pojavljuje okvir za dijalog Function Arguments koji prikazuje argumente

funkcije SUM (slika 2-17). Upravo ovde upisujete argumente funkcije Sum.
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Kao $to moZete procitati u okviru za dijalog Function Arguments (slika
2-17), ova funkcija omogucava izbor do 30 argumenata (sabiranje najvise
30 brojeva). Ono §to, medutim, nije oc¢igledno (uvek postoji neka zvrcka!)
jeste to Sto ovi brojevi ne moraju da se nalaze u jednoj celiji. U stvari,
najcesce ce se deSavati da izaberete mnostvo brojeva u susednim celi-
jama (izbor vise Celija - tj. podrucja celija) koje hocete da saberete.
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98 Deo I: Ulazak na osnovni nivo

Da biste izabrali prvi numericki argument u okviru za dijalog, dok je kur-
sor u polju Number1, pritisnite miSem jedanput celiju (ili prevucite
preko bloka celija) na radnom listu. Excel ¢e prikazati adresu celije
(odnosno adresu podrucja) u polju Numberl. U isto vreme prikazace, u
polju s desne strane, vrednost koja se nalazi u €eliji (odnosno vrednosti,
ako ste izabrali veci broj c¢elija). Ukupan zbir prikazace sasvim na dnu
okvira za dijalog Function Arguments, posle re¢i Formula result=.

Prilikom biranja celija, imajte na umu da ovaj okvir za dijalog sa argu-
mentima moZete smanjiti (tako da se vide samo polje Numberl1 i jedno
dugme za uvecanje), pritiskom na dugme za smanjenje okvira za dijalog
koje se nalazi desno od polja Numberl. Posto ste smanjili okvir za dijalog
sa argumentima tako da mozete da izaberete celije koje ce biti upotre-
bljene kao prvi argument, ponovo ga mozZete povecati pritiskom na
dugme za povecanje okvira za dijalog (to je jedino dugme prikazano
krajnje desno) ili pritiskom na taster Esc. Umesto da okvir za dijalog sma-
njite, moZete ga pomeriti u stranu - pritisnite miSem bilo gde na njegovoj
povrsini, a zatim ga prevucite na drugo mesto.

Ako sabirate viSe od jedne celije (ili grupe celija) iz radnog lista, priti-
snite taster Tab, ili pritisnite miSem polje Number2, tako da se kursor
premesti u njega (Excel na to reaguje prosirivanjem liste argumenata
-otvara jo$ jedno polje, Number3). U polju Number2 zadacete drugu
Celiju (ili podrucje celija) koja treba da se doda onoj u polju Number1.
Posto pritisnete miSem celiju (ili prevucete pokaziva¢ preko sledeceg
podrucja), program ce prikazati adresu Celije (odnosno podrucja); broj
koji se nalazi u celiji (odnosno brojevi u Celijama podrucja) bice prika-
zan(i) s desne strane polja, a trenutni ukupni zbir — na dnu okvira za dija-
log Function Arguments, desno od Formula result= (Slika 2-17). Ne zabo-
ravite da, pritiskom na dugme za smanjenje, ceo okvir za dijalog moZete
svesti na polje za argument koje trenutno popunjavate (Number2, Num-
ber3 itd.) i dugme za uvecanje. Svako polje za argument ima na svojoj des-
noj strani odgovarajuce dugme za smanjenje. Upotrebite ga ako vam okvir
za dijalog zaklanja €eliju (ili ¢elije) koju hocete da izaberete.

Kada odaberete celije, odnosno grupe Celija koje treba sabrati, pritisnite
dugme OK da biste zatvorili okvir za dijalog Function Arguments i posta-
vili funkciju SUM u aktivnu celiju.

Uredivanje funkcije pomocu dugmeta
Insert Function

Dugme Insert Function omogucuje da uredujete formule (posebno one
koje sadrze funkcije) neposredno na traci za formule. Da biste ga upotre-
bili, izaberite celiju sa formulom koju hocete da izmenite pre nego Sto
pritisnete dugme Insert Function (ono koje ima znak fx i nalazi se na traci
za formule, neposredno ispred polja sa sadrzajem aktivne celije).
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Poglavlje 2: Izrada radnog lista od samog pocetka 99

Kada pritisnete dugme Insert Function, Excel otvara okvir za dijalog
Function Arguments u kome moZete menjati argumente ove funkcije. Ako
hocete da menjate samo argumente funkcije, izaberite reference celija

u odgovaraju¢im poljima za argumente (Numberl, Number2, Number3
itd.), a zatim unesite potrebne izmene adresa celija ili izaberite novo
podrucje Celija. Imajte na umu da ¢e Excel teku¢em argumentu automatski
dodati bilo koju celiju ili podrucje celija koje istaknete na radnom listu.
Ako hocete da zamenite tekuci argument, izaberite (istaknite) ga i, priti-
skanjem tastera Delete, otarasite se adresa njegovih celija pre nego Sto
izaberete novu celiju ili podrucje celija koje ¢e posluziti kao novi argu-
ment. (Ne zaboravite da uvek moZete da smanjite ovaj okvir za dijalog
ili da ga premestite ako vam zaklanja cCelije koje hocete da izaberete.)

Kada zavrsite uredivanje formule, pritisnite taster Enter ili dugme OK u
okviru za dijalog sa argumentima kako biste ga uklonili i azurirali formulu
na radnom listu.

Bio bih potpuno izgubljen bez AutoSuma

Pre nego §to napustimo ovu fascinantnu diskusiju o uvodenju funkcija,
Zelim da vas uputim u alatku AutoSum s palete Standard (izgleda kao
veliko slovo sigma - X — grckog alfabeta). Ova alatka vredi zlata — ne
samo da uvodi funkcije Sum, Average, Count, Max ili Min, ve¢ u isto
vreme bira najverovatnije podrucje celija u tekucoj koloni ili teku¢em
redu Ciji ukupan zbir traZite i automatski ih unosi kao argumente te
funkcije. U devet od deset slucajeva Excel izabere (isticanjem) tacéno ono
podrucje Celija koje vam odgovara. U onom desetom slucaju, ru¢no cete
zadati podrucje povlacenjem pokazivaca preko bloka celija koje treba
sabrati.

Kada pritisnete dugme AutoSum (Sto i njegovo ime oznacava), podra-
zumeva se da se u aktivnu celiju ubacuje funkcija Sum. Ako Zelite da
pritiskom na ovo dugme izaberete neku drugu funkciju, na primer Aver-
age, Count, Max ili Min, pritisnite dugme sa trouglicem da biste otvorili
padajucu listu i izaberite ime funkcije. Ako u ovoj listi izaberete stavku
More Functions, Excel otvara okvir za dijalog Insert Function, bas kao

i kada pritisnete dugme fx na traci za formule.

Slika 2-18 prikazuje kako se koristi alatka AutoSum za izracunavanje
ukupne prodaje firme Dijetni centri Spartanac u tre¢em redu. Postavite
pokazivac u celiju E3, gde se nalazi ukupan zbir za prvi kvartal, a zatim
pritisnite dugme AutoSum. Excel ubacuje funkciju SUM (sa znakom jed-
nakosti i ostalim Sto je potrebno) u polje za formule, iscrtava pokretnu
isprekidanu liniju (engl. marquee) oko celija B3, C3 i D3, i koristi podrucje
Celija B3:D3 kao argument funkcije SUM.
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Slika 2-19 prikazuje kako izgleda radni list poSto je umetnuta ova funkcija
u Celiju E3. [zracunati zbir se pojavljuje u celiji E3, a u polju za formule
pojavljuje se sledeca formula:

=SUM(B3:D3)
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Nakon unosSenja funkcije za izracunavanje ukupne prodaje firme Dijetni
centri Spartanac, ovu formulu moZete iskopirati da biste odredili koliko
je iznosila ukupna prodaja ostalih kompanija — povucite rucicu za
popunu niz kolonu E dok ne istaknete podrucje celija E3:E9.

Slika 2-20 ilustruje nacin upotrebe alatke AutoSum za odredivanje uku-
pne prodaje u januaru svih firmi preduzeca Labava poslovna grupacija
u koloni B. Postavite pokazivac u c¢eliju B10 gde treba da se nade ukupan
zbir. Kada pritisnete dugme AutoSum, Excel postavlja isprekidani okvir
oko celija B3 do B9 i upisuje podrucje cCelija B3:B9 kao argument funkcije
AutoSum.
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Slika 2-21 prikazuje kako izgleda radni list nakon umetanja ove funkcije
u Celiju B10 i upotrebe opcije AutoFill za kopiranje ove formule u celije
C10, D101 E10. (Prevucite rucicu za popunu udesno preko celija dok ne
stignete do celije E10, a zatim otpustite taster misa).
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Osiguravanje bezbednosti i pouzdanosti
podataka

Sav posao koji uradite na bilo kom radnom listu u svojoj radnoj svesci
izloZen je riziku sve dok radnu svesku ne snimite kao datoteku na disk.
Ako nestane struje ili vas racunar zapne iz bilo kog razloga pre nego Sto
ste snimili radnu svesku, niste imali srece. Moracete da sve uradite
ponovo — mucan posao, utoliko teZi Sto je moglo i bez toga. Da biste

se sasvim zastitili od ovakvih neprijatnih situacija drzite se sledeceg
pravila: snimite svoj rad na disk svaki put kada procenite da ste uneli
toliko podataka da ne biste mogli da podnesete da ih izgubite.
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Da bi vas ohrabrio da Cesto snimate, Excel je obezbedio i dugme Save na
paleti Standard (dugme sa sli¢icom diskete, trece sleva). Ne morate da
zadajete komandu Save iz menija File, Cak ni da pritiskate kombinaciju
tastera Ctrl+S — dovoljno je da miSem pritisnete ovo dugme i vas rad bice
sacuvan na disku.

Kada prvi put upotrebite ovu alatku, Excel prikaZe okvir za dijalog Save
As. U ovom okviru za dijalog moZete da zamenite privremeno ime doku-
menta (Bookl, Book2 itd.) imenom koje ga bolje opisuje, i da izaberete
disk i direktorijum pre nego Sto radnu svesku snimite na disk. To je
sasvim jednostavno:

v’ Da biste promenili ime radne sveske, upiSite ime datoteke u polje
File name. Kada prvi put otvorite okvir za dijalog Save As, istaknuto
je predloZeno ime tipa Bookl; upiSite novo ime preko njega.

v Da biste izabrali disk na kome c¢e radna sveska biti snimljena, priti-
snite dugme za otvaranje padajuce liste Save in, a zatim pritisnite
odgovarajuce ime diska, na primer, Hard disk (C:) ili 3 1/2 Floppy
(A)) iz padajuce liste.

v Da biste izabrali direktorijum u kome cete sacuvati radnu svesku,
prvo izaberite disk ako je potrebno (opisano napred), a zatim priti-
snite direktorijum. Ako radnu svesku hocete da sacuvate u direkto-
rijumu koji se nalazi unutar nekog od direktorijuma prikazanih u
polju s listom direktorijuma, pritisnite dvaput taj direktorijum. Kad
je sve gotovo, ime direktorijuma u kome ¢e radna sveska biti sacu-
vana pojavljuje se u polju Save in.

Ako radnu svesku hocete da sacuvate u novom direktorijumu,
pritisnite dugme Create New Folder (napravi nov direktorijum).
Otvorice se okvir za dijalog New Folder. U polje za ime upiSite ime
direktorijuma, a zatim pritisnite dugme OK ili taster Enter.

Excelov okvir za dijalog Save As u verziji 2003 ima nekoliko velikih dug-
madi koja se pojavljuju s leve strane okvira: My Recent Documents, Desk-
top, My Documents, My Computer i My Network Places. Pritiskom na
odgovarajuce dugme izabracete sledece direktorijume da biste u njima
snimili datoteke novih radnih svezaka:

v Pritisnite dugme My Recent Documents da biste snimili radnu
svesku u direktorijum Recent. Ovaj direktorijum se nalazi u direk-
torijumu Office smeStenom unutar direktorijuma Microsoft, koji je
unutar direktorijuma Application Data, a svi oni u direktorijumu
Windows na disku vaSeg raCunara.

v’ Ukoliko se opredelite za Desktop, snimicete radnu svesku na radnu
povrsinu racunara.

v Pritisnite dugme My Documents da biste radnu svesku snimili
u istoimeni direktorijum.
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v Pritiskom na dugme My Computer radnu svesku cete snimiti na
jedan od diskova vaSeg racunara, u direktorijum s licnim vasim
dokumentima ili u deljeni direktorijum koji se nalazi na disku
racunara.

v Pritisnite dugme My Network Places da biste snimili radnu svesku u
jedan od direktorijuma koji se nalazi na mreZi firme u kojoj radite.

Pod operativnim sistemom Windows XP, imena datoteka mogu da sadrze
prazna mesta (razmake) i do 255 znakova (nadam se da vam ne treba ime
datoteke dugacko koliko i ceo jedan pasus). To je vaZzna novost, pogo-
tovu ako ste bili korisnik DOS-a ili Windowsa 3.1 i tako dugo trpeli zbog
ograniCenja imenovanja po Semi osam-tacka-tri. Ipak povedite racuna o
imenovanju svojih radnih svezaka ukoliko nameravate da ih prebacite na
masinu koja ne koristi Windows XP, 98, Windows Me ili Windows 2000,
posto ¢e imena datoteka biti drasticno skracena i dobiti nastavak .xls,
tipican za Excelove datoteke (uzgred, ovaj nastavak zadrzZan je i u dato-
tekama napravljenim u Excelu 2003: stvar je u tome §to je Windows XP
dovoljno uvidavan da vam ovaj nastavak skloni sa ociju).

Kada zavrsite rad u okviru za dijalog Save As, pritisnite dugme Save ili
taster Enter da bi Excel 2003 sacuvao vas rad. Kada Excel snima datoteku
radne sveske, on snima sve informacije u svim radnim listovima (ukljuc¢u-
judi i poslednju poziciju pokazivaca celije) u zadatom direktorijumu i na
zadatom disku. Nakon toga, okvir za dijalog Save As viSe vam nece tre-
bati ukoliko ne poZelite da promenite ime radnoj svesci ili da njenu
kopiju snimite u neki drugi direktorijum. Tada cete morati da upotrebite
komandu Save As iz menija File, poSto pritisak na dugme Save ili kombi-
nacija tastera Ctrl+S nece otvoriti okvir za dijalog Save As.

Spasavanje dokumenata

NET

Excel 2003 sadrzi novu opciju za vracanje dokumenta u normalno stanje
(engl. document recovery) koja moZe biti od velike koristi u raznim
nepredvidljivim situacijama: ukoliko racunar iznenada ostane bez napa-
janja elektricnom energijom, ili se neki deo operativnog sistema blokira
pa morate da ponovo pokrenete racunar. Opcija AutoRecover radi tako
Sto u odredenim intervalima snima radne sveske na disk. U slucaju da su
se desile bilo kakve nepravilnosti u radu racunara, sledeci put prilikom
pokretanja Excela (posto ste prethodno ponovo pokrenuli racunar),

u levom delu ekrana otvorice se okno Document Recovery.

Kada prvi put pocCnete da koristite Excel 2003, opcija AutoRecover
automatski, svakih deset minuta, snima sve promene nacinjene u radnoj
svesci (pod uslovom da je datoteka prethodno snimljena pod odredenim
imenom). Ovaj interval moZete skratiti ili produziti po Zelji. Izaberite
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Tools = Options, a zatim pritisnite karticu Save. Koristite dugmad bro-
jaca (engl. spinner buttons) ili ru¢no upiSite novu vrednost u polje ozna-
Ceno sa Save AutoRecover Info Every 10 Minutes. Zatim pritisnite OK.

U oknu Document Recovery prikazane su raspolozive verzije dokume-
nata koji su bili otvoreni prilikom prestanka rada racunara. Ova opcija
identifikuje originalnu verziju datoteke, vreme kada je snimljena, kao

i verzije datoteke koja je vracena u normalno stanje (,,spasena“) i vreme
njenog snimanja. Da biste otvorili spasenu datoteku (i videli koliko je
posla propalo jer niste na vreme snimili sve podatke), postavite poka-
zivaC miSa iznad odgovarajuce verzije dokumenta. Zatim pritisnite
dugme koje otvara pomoc¢ni meni i izaberite Open. Kada otvorite opo-
ravljenu verziju, unete promene moZzete (ako Zelite) snimiti izborom
komande File &> Save iz menija.

Da biste snimili oporavljenu verziju radne sveske, ne troseci vreme na
njeno otvaranje, prvo postavite pokaziva¢ miSa iznad oporavljenje ver-
zije, pritisnite njeno dugme koje otvara pomoc¢ni meni i izaberite opciju
Save As. Da biste se zauvek odrekli oporavljene verzije (ostavljajuci

u datoteci samo podatke iz originalne verzije), pritisnite dugme Close

u dnu okna Document Recovery. Kada pritisnete dugme Close, pojavice
se okvir sa upozorenjem, sto ¢e vam dati Sansu da ipak, za kasnije,
zadrzZite oporavljene verzije datoteke. Ako Zelite da zadrzite datoteke
da biste ih kasnije razgledali, pritisnite radio-dugme Yes (Da, Zelim da
kasnije pogledam ove datoteke), a zatim OK. Ukoliko vam trebaju samo
originalne verzije datoteka prikazane u okviru Document Recovery,
pritisnite radio-dugme No (Ne, ukloni ove datoteke. Sacuvao/la sam
datoteke koje mi trebaju).

Imajte u vidu da opcija AutoRecover radi samo u Excelovim radnim
sveskama koje ste barem jednom snimili (kao Sto je ranije objasnjeno

u odeljku ,,Osiguravanje bezbednosti i pouzdanosti podataka®). Drugim
reCima, ako napravite novu radnu svesku i ne potrudite se da je snimite
i da joj dodelite ime pre nego Sto racunar otkaZe, opcija AutoRecover
nece mocdi da povrati nijedan njen deo. Zato je izuzetno vazno da
steknete naviku snimanja novih radnih svezaka komandom File=> Save,
vrlo brzo posto zapocCnete rad na nekom radnom listu. Ili, ako vam se
viSe svida, koristite proverenu precicu s tastature, Ctrl+S.
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